EPLAN NEWS
for Version 2.5
Status: 23.06.2015

EPLAN Software & Service GmbH & Co. KG
Technical Information
Copyright © 2015 EPLAN Software & Service GmbH & Co. KG

EPLAN Software & Service GmbH & Co. KG assumes no liability for either technical or printing errors, or for deficiencies in this technical information and cannot be held liable for damages that may result directly or indirectly from the delivery, performance, and use of this material.

This document contains legally protected proprietary information that is subject to copyright. All rights are protected. This document or parts of this document may not be copied or reproduced by any other means without the prior consent of EPLAN Software & Service GmbH & Co. KG.

The software described in this document is subject to a licensing agreement. The use and reproduction of the software is only permitted within the framework of this agreement.

RITTAL® is a registered trademark of Rittal GmbH & Co. KG.

EPLAN®, EPLAN Electric P8®, EPLAN Fluid®, EPLAN Preplanning®, EPLAN PPE®, EPLAN Pro Panel® and EPLAN Harness proD® are registered trademarks of EPLAN Software & Service GmbH & Co. KG.


PC WORX®, CLIP PROJECT®, and INTERBUS® are registered trademarks of Phoenix Contact GmbH & Co.

AutoCAD® and AutoCAD Inventor® are registered trademarks of Autodesk, Inc.

STEP 7®, SIMATIC® and SIMATIC HW Konfig.® are registered trademarks of Siemens AG.

InstallShield® is a registered trademark of InstallShield, Inc.

Adobe® Reader® and Adobe® Acrobat® are registered trademarks of Adobe Systems Inc.

TwinCAT® is a registered trademark of Beckhoff Automation GmbH.

Unity Pro® is a registered trademark of Schneider Electric.

RSLogix 5000® and RSLogix Architect® are registered trademarks of Rockwell Automation.

All other product names and trade names are trademarks or registered trademarks of their respective owners.

EPLAN uses the Open Source software 7-Zip (7z.dll). Copyright © by Igor Pavlov. The source code of 7-Zip is subject to the GNU Lesser General Public License (LGPL). The source code of 7-Zip and details on this license can be found on the following Web site: http://www.7-zip.org

EPLAN uses the open-source software Open CASCADE, Copyright © by Open CASCADE S.A.S. The source code of Open CASCADE is subject to the Open CASCADE Technology Public License. The source code of Open CASCADE and details on this license can be found on the following Web site: http://www.opencascade.org

EPLAN provides an import function which uses eCl@ss. Usage of the eCl@ss standard is subject to license and requires registration and ordering in the DownloadPortal: http://www.eclassdownload.com
# Table of Contents

**Preface** ........................................................................................................................................... 9  
**Notes for the Reader** ........................................................................................................................... 11  
**New Features of the Entire EPLAN Platform** ....................................................................................... 14  
  **Extensions at Macro Projects** ........................................................................................................... 14  
    New navigator for macro projects ....................................................................................................... 15  
    Definition of macros in a macro project .............................................................................................. 17  
    Menu items for macro projects .......................................................................................................... 19  
  **New EPLAN Help System** .................................................................................................................. 21  
    New user interface elements ................................................................................................................. 22  
    Calling up the help system via an Internet connection ...................................................................... 25  
  **User Interface** ................................................................................................................................... 27  
    Combination of selection and activation at filtering ........................................................................... 27  
    Less Control Elements for More User-friendliness ........................................................................... 28  
  **Graphical Editor** .............................................................................................................................. 32  
    Oval text box ....................................................................................................................................... 32  
    Improved positioning of texts ............................................................................................................ 33  
    Application of formattings for graphical elements ............................................................................ 35  
    Correct Representation of Line Types ................................................................................................ 35  
  **Devices** ............................................................................................................................................... 37  
    Simplification and extension of the property arrangements ............................................................... 37  
    Extended automatic coordinates for property arrangements ............................................................ 41  
  **Project Editing** ............................................................................................................................... 44  
    Update the project databases .............................................................................................................. 44  
    Correcting project data ....................................................................................................................... 45  
    Utilization of the non-norm-compliant structure setting “Superior” .................................................. 47  
  **Defined Devices** .............................................................................................................................. 49  
    Modules for differing device identification standards .......................................................................... 49  
    Extensions for device groups .............................................................................................................. 51
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Data Navigators</td>
<td>52</td>
</tr>
<tr>
<td>Uniform behavior during placing and inserting devices</td>
<td>52</td>
</tr>
<tr>
<td>Bill of Materials Navigator</td>
<td>54</td>
</tr>
<tr>
<td>Assigning item numbers structure- or page-specifically</td>
<td>54</td>
</tr>
<tr>
<td>External editing</td>
<td>56</td>
</tr>
<tr>
<td>Extended functionality of path function texts</td>
<td>56</td>
</tr>
<tr>
<td>Reports</td>
<td>57</td>
</tr>
<tr>
<td>Changes in the user interface</td>
<td>57</td>
</tr>
<tr>
<td>Parts Management</td>
<td>58</td>
</tr>
<tr>
<td>Update the parts database</td>
<td>58</td>
</tr>
<tr>
<td>Offset for connection point pattern</td>
<td>58</td>
</tr>
<tr>
<td>Settings</td>
<td>60</td>
</tr>
<tr>
<td>Uniform settings for databases</td>
<td>60</td>
</tr>
<tr>
<td>Application of Settings</td>
<td>61</td>
</tr>
<tr>
<td>Utilities</td>
<td>61</td>
</tr>
<tr>
<td>Optimization of the system message management</td>
<td>61</td>
</tr>
<tr>
<td>New Features in the &quot;EPLAN Multi-User Management&quot; Extension Module</td>
<td>63</td>
</tr>
<tr>
<td>Simplified activation of defined work sections</td>
<td>63</td>
</tr>
<tr>
<td>New Features in the &quot;EPLAN Revision Management&quot; Extension Module</td>
<td>64</td>
</tr>
<tr>
<td>Revisioning defined working sections</td>
<td>64</td>
</tr>
<tr>
<td>Controlling the application of revision data during inserting</td>
<td>65</td>
</tr>
<tr>
<td>New Features in the &quot;EPLAN User Rights Management&quot; Extension Module</td>
<td>69</td>
</tr>
<tr>
<td>New Features for EPLAN Electric P8</td>
<td>70</td>
</tr>
<tr>
<td>Terminals</td>
<td>70</td>
</tr>
<tr>
<td>New property &quot;Device list&quot;</td>
<td>71</td>
</tr>
<tr>
<td>Device-oriented View in the Terminal Strip Navigator</td>
<td>72</td>
</tr>
<tr>
<td>Improvements in editing terminals</td>
<td>73</td>
</tr>
<tr>
<td>Simplified working with manual saddle jumpers</td>
<td>78</td>
</tr>
<tr>
<td>New Features in the &quot;EPLAN FieldSys&quot; Extension Module</td>
<td>80</td>
</tr>
<tr>
<td>Routing of single-line cables</td>
<td>81</td>
</tr>
</tbody>
</table>
Consideration of Height Differences during Routing .................................. 82
Automatic generation of topology functions ................................................. 85
Determining the order length ....................................................................... 90
New properties for the routing path type .................................................... 91

New Features for EPLAN Pro Panel ............................................................... 94

Standardized and Automated Creation of Manufacturing Drawings .......... 95
Generating Pages with Views Automatically ................................................ 96
Automatic dimensioning ............................................................................. 98
Numbering view names consecutively .......................................................... 102
Well-structured tab "View" ........................................................................... 103
Rotating drilling views by 180° ................................................................. 104

Extensions when Placing Parts .................................................................. 104
Multiple placement of enclosures with defined spacings ......................... 104

Improved Maintenance of 3D Macros by Means of the Macro Navigator ... 105

Extended Settings for Routing Connections ................................................ 106
Orthogonal connection form within routing ranges .................................... 106

Extensions in the Generation of Manufacturing Data for NC Machines .... 107
Settings for zero position for length-variable items .................................... 107

New Features in the "NC Perforex" Extension Module .................................. 109
Further material numbers for the Kiesling NC export ............................... 109

New Features for EPLAN Preplanning ......................................................... 111
Links in Pre-Planning .................................................................................. 112

Configuration of Segment Definitions ....................................................... 115
Write protection for the structure identifiers of structure segments .......... 115

Extensions for PCT Loops .......................................................................... 118
Improved representation of PCT loops in accordance with the standard DIN EN 62424 .......................................................... 118

Extended Numbering Settings .................................................................... 120
Retain leading zeros during numbering ...................................................... 120
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation of Schematics from the Pre-Planning</td>
<td>120</td>
</tr>
<tr>
<td>Creation of schematics from the list</td>
<td>120</td>
</tr>
<tr>
<td>Multiple selection when updating the detailed planning</td>
<td>121</td>
</tr>
<tr>
<td>Checking the Pre-Planning</td>
<td>122</td>
</tr>
<tr>
<td>Display of faulty segments</td>
<td>122</td>
</tr>
<tr>
<td>New check run messages for pre-planning</td>
<td>122</td>
</tr>
<tr>
<td>Properties for Pre-planning</td>
<td>123</td>
</tr>
<tr>
<td>Deviating structure identifiers at the planning objects</td>
<td>123</td>
</tr>
<tr>
<td>Renamed properties</td>
<td>124</td>
</tr>
<tr>
<td>New Features for EPLAN Fluid</td>
<td>125</td>
</tr>
<tr>
<td>Extensions for the EPLAN Fluid Hose Configurator</td>
<td>125</td>
</tr>
<tr>
<td>New Features for EPLAN CPM</td>
<td>127</td>
</tr>
<tr>
<td>New Features in the &quot;EPLAN API Extension&quot; Extension Module</td>
<td>129</td>
</tr>
<tr>
<td>New Features in the Master Data</td>
<td>134</td>
</tr>
<tr>
<td>Master data: Symbols</td>
<td>134</td>
</tr>
<tr>
<td>Master data: Forms and Plot Frames</td>
<td>142</td>
</tr>
<tr>
<td>Master data: Function Definition Library</td>
<td>144</td>
</tr>
<tr>
<td>Master data: Projects and Templates</td>
<td>145</td>
</tr>
<tr>
<td>Master data: Macros</td>
<td>145</td>
</tr>
<tr>
<td>Other New Features and Information</td>
<td>146</td>
</tr>
<tr>
<td>EPLAN Solution Center – The New Support System</td>
<td>146</td>
</tr>
<tr>
<td>Logging into the EPLAN Solution Center</td>
<td>147</td>
</tr>
<tr>
<td>Validation Code</td>
<td>149</td>
</tr>
<tr>
<td>Retrieving the Validation Code Online</td>
<td>149</td>
</tr>
<tr>
<td>Software Requirements and Approvals</td>
<td>151</td>
</tr>
<tr>
<td>General requirements</td>
<td>151</td>
</tr>
<tr>
<td>Operating systems</td>
<td>151</td>
</tr>
<tr>
<td>Microsoft products</td>
<td>152</td>
</tr>
<tr>
<td>Feature</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>SQL Server (64 bit)</td>
<td>152</td>
</tr>
<tr>
<td>Autodesk Server (64 bit)</td>
<td>153</td>
</tr>
<tr>
<td>PDF redlining</td>
<td>153</td>
</tr>
<tr>
<td>PLC systems (PLC &amp; bus extension)</td>
<td>153</td>
</tr>
<tr>
<td>64-bit version of the EPLAN platform</td>
<td>154</td>
</tr>
</tbody>
</table>
Preface

Dear EPLAN users,

On the Hanover Fair 2015 the focus for EPLAN lay on engineering in the context of Industry 4.0 and in particular the added value chain of customers. Innovative application possibilities of a consistent engineering approach were presented on the stands of the SmartFactory\(^K\)L and Smart Engineering and Production 4.0.

The new version of the EPLAN platform manages engineering data from basic engineering through detailed engineering up to production and service. The focus here lies on rapid processing and simple management - be fascinated by the new possibilities opened up by the EPLAN platform 2.5.

In the last years the technology of terminals has continued to be developed further. Nowadays terminals are complex components for manifold fields of use. As of Version 2.5 an extended editing dialog for terminals is now available to you. A graphical representation of the terminals and the editing functions allow rapid editing and validation of the terminal strip.

With the new macro navigator you manage your schematic templates in the macro project even more clearly structured. A high-quality template library ensures the quality in project planning and accelerates the schematic generation.

In the past the routing of cables required detailed planning. In connection with single-line designing you can now realize the cable planning in single-line representation. The special highlight: This information can then be passed on to the EPLAN FieldSys extension module, thus allowing the cable routes and required cable lengths to be determined.
In fluid-power and electrical-engineering projects with 3D mounting layouts you can now in Version 2.5 generate the required drawings and documentation for production in a standardized manner and to a large extent automatically.

In connection with the new automatic dimensioning of device positions, drill holes or cut-outs within model views, the EPLAN Pro Panel Version 2.5 allows standardized, automatic and thus time-saving creation of production documents.

**EPLAN Experience**

Always staying on the same path gives one security. So why should one try out new paths, when the tried and tested one leads to the desired result? "Because it’s worth it" in our opinion – which is why we have started the EPLAN Experience. On the basis of eight fields of action we point out new potentials in the engineering process. Ask EPLAN how the EPLAN Experience can help you make your process even more efficient.

Get a head start and discover numerous functionalities and improvements in the EPLAN platform Version 2.5. Further information about the new version is available on our website under www.eplan.de/en/start.

We wish you much success with your new EPLAN platform 2.5!

Your EPLAN Software & Service team
Notes for the Reader

Important information:

- *Before installing* the new version please read the information in "Other New Features and Information" (from Page "146") onwards. Read in particular the section "Software Requirements and Approvals" (see Page "151").

- As of Version 2.5 the EPLAN Platform is only available in a 64-bit version. Please read the subsection "64-bit version of the EPLAN platform" (see Page "154") in the section "Software Requirements and Approvals" for further information.

- If you want to use *old projects* that were created with previous EPLAN versions in EPLAN Version 2.5, these projects have to be updated. For further information read the section "Project Editing" (see Page "44").

- If you want to use an *older* parts database, you will first have to update such a parts database. For further information read the section "Parts Management" (see Page "58").

- We used "EPLAN Electric P8" when creating the images for this document. If you use a different program of the EPLAN Platform, a different program icon will be displayed in the dialog of your program.

Before you begin reading, please note the following symbols and styles used in this document:
**Warning:**

Text preceded by this symbol contains a warning; you should be absolutely sure to read this warning before proceeding!

**Note:**

Text preceded by this image contains extra notes.

**Tip:**

Useful tips to facilitate your interaction with the program are presented after this image.

**Example:**

Examples are highlighted by this symbol.

- User interface elements are marked in **bold** (and **blue**) so they can immediately be located in the text.

- *Italic* text provides particularly important information that you should definitely pay attention to.

- Code examples, directory names, and direct input (among others) are displayed in a non-proportional font.

- Function keys, keyboard keys, and buttons within the program are shown in square brackets (e.g., **[F1]** for the "F1" function key).
To improve the flow of the text, we often use "menu paths" in this document (for example, Help > Contents). In order to find a particular program function, the menus and options shown in a menu path must be selected in the sequence shown. For example, the menu path mentioned above calls up the EPLAN help system.

In combination with settings or fields (e.g., check boxes) which can only be switched on or off, in this document we often use the term "activate" (after which the setting is active ☑) and "deactivate" (after which the setting is inactive ☐).
New Features of the Entire EPLAN Platform

Extensions at Macro Projects

High-quality schematic templates form the basis for efficient project planning. With the creation and management of such schematic templates the EPLAN macro technology offers extensive possibilities. In order to use these possibilities effectively we urgently recommend that you carry out the preparation of the macro master data solely in a macro project. In order to support you better in this approach in future, we have differentiated macro and schematic projects much more clearly from each other than in the past (special menu items only for macro projects).

In addition we have integrated new functionalities for the preparation of macros – for example the viewing of the prepared macros by the new macro navigator has been facilitated. We have provided a new possibility for the definition and combination of macros so that you can used macro boxes, pages or layout spaces that have been prepared once several times.

We discuss the following topics in the next sections:

- "New navigator for macro projects" on Page "15"
- "Definition of macros in a macro project" on Page "17"
- "Menu items for macro projects" on Page "19".

Please also inform yourself under http://www.eplanexperience.com about "EPLAN Experience" – your path to more efficiency. A methodical step-by-step procedure for optimizing your engineering efficiency.
New navigator for macro projects

In a macro project macros can be defined in different representation types and per representation type in several variants on several pages or in different layout spaces – depending on whether they are window, symbol, page or 3D macros. The new macro navigator is now available for a well-structured display and management of the macros stored in a *macro project*.

**Benefit:**

The new macro navigator allows rapid and simple selection of a special macro variant in a macro project. The hierarchical tree structure provides you with a simple overview of the macros to be generated and the resulting macro directories.

Management of the page macros via page structures is thus no longer required.

**Note:**

Please note that the display of prepared macros to be generated automatically in the macro navigator is only possible in a macro project. The macro navigator remains empty in a schematic project.

To open the macro navigator, select the menu items **Project data > Macros > Navigator**.

**Tree view**

In the **Tree** tab, the macros to be generated are displayed in a hierarchical structure. The top hierarchy level is the project. The directory structure in which the macros are stored within the set macro directory is represented below it.
Below the macros to be generated their representation types and variants are displayed. In the process different icons are used for the various macro types and the same icons as for the page types for the representation types.

The macro files to be generated are identified by the following icons:

- Window macro:
- Page macro:
- Symbol macro:

**Note:**

From the prepared 3D macros that are stored in the layout spaces of a macro project, 3D window macros (*.ema) or 3D symbol macros (*.ems) are generated. Correspondingly the same icons are also displayed for these prepared 3D macros as for the 2D-window or 2D symbol macros.

**List view**

The macro name, the representation type, the variant, the description and the file name of the macro to be generated are displayed by default in the Tab list. The displayed properties can be configured using the popup menu.

**Editing possibilities**

- If you mark a prepared macro in the macro navigator, the corresponding page / layout space of the macro project is displayed in the graphical preview.

- You can use the popup menu to view and edit the properties of the macro to be generated. In the process the respective property dialog is opened (for example the property dialog of a macro box for a window macro to be generated).
By means of the popup menu item **Go to (graphics)** you jump into the graphical editor or into a layout space and can there edit the respective schematic section or the respective 3D object types.

Filters can be used to limit the display to the macros to be generated that fulfill specific criteria. This allows you to, for example, have only the macros of a specific representation type displayed and subsequently generated automatically.

You can synchronize the selection between the objects for the macros in the graphical editor / layout space and the macro navigator.

You can automatically generate macros from the prepared macros of the macro project that are displayed in the macro navigator.

**Definition of macros in a macro project**

The **Macro definition** tab is now available for the specifications of the names and descriptions of macros during the preparation of macros in a macro project. In a macro project this tab is displayed in the property dialogs of macro boxes, pages or layout spaces. In a **schematic project** this tab is not displayed.
During the automatic generation of macros from a macro project the specifications carried out here are used for the macro files to be generated.

**Benefit:**

*The Macro definition* tab allows you to utilize the prepared macro boxes, layout spaces or pages of a macro project several times and to store them in different macro files. Several macro files can thus be generated from a prepared macro in the macro project. The required management work is reduced.

**Procedure:**

- If you use a prepared macro box, a layout space or a page *in only one macro*, you can also continue to carry out your entries in the *Macro box* or in the properties *Macro: Name* and *Macro: Description* on the *Layout space* or *Page* tab.

- If you want to assign a prepared macro box, a layout space or a page *to several macros*, use the *Macro definition* tab. Enter the respective name and the description of the macros in the lines. During automatic generation the same content (same macro box, same page or same layout space) is stored in several macros.

**Note:**

The values entered in the first line serve to define the first macro. As soon as you have carried out entries in the first line, these are compared with the values of the properties for the macro name and the macro description. At a macro box, for example, the values in the *Name* and *Description* fields on the *Macro box* tab are synchronized with the entries in the first line of the *Macro definition* tab.
The use of a macro box or layout space in several macro files is of interest when one macro is to be created per device. In such a case it often happens that one representation type is always the same, while another representation type always differs. This is for example the case at PLC cards at which the single-line representation is often the same, while in the multi-line representation different PLC connection points are used depending on the device. Through the macro definition you can assign several macro names to the macro box / layout space with the repeatedly same representation type.

Indexed page properties for macros

In the EPLAN platform it has been possible for some time to assign a page to several page macros. In the previous versions this assignment and the specification of the description was carried out in the page properties by means of the indexed properties Macro: Name [1-100] (ID 11008) and Macro: >Description [1-100] (ID 11014).

These properties are now no longer available in a macro project in the property dialogs of pages – the specification of the macro names for page macros is now also carried out by means of the Macro definition tab.

When you open and update old macro projects (from Version 2.4 and older), in which page macros were defined using the indexed properties, the specified macro names and descriptions are displayed in the Macro definition tab.

Menu items for macro projects

In order to differentiate macro and schematic projects more clearly from each other, two menu items were moved from the menu path Utilities > Generate macros into the menu Project data below the new menu item Macros. These menu items are only active in Macro projects – as in the past.
As of the new version some functionalities can now also only be carried out in macro projects. This relates to the following menu items:

- **Edit > Other > Group device**
- **Insert > Box / connection point / mounting panel > Macro box.**

The generation of unplaced functions does not make sense in macro projects. Therefore the following menu item is only still active in **Schematic projects**:

- **Edit > Delete placement.**
New EPLAN Help System

The EPLAN help system has been revised for the current version. The HTML help format used in previous versions (*.chm) has been replaced by the new HTML5 format. This format has important advantages compared to the old help format:

- Display in the Internet browser set by default
- New modern design of the user interface
- Extended text search with synonyms
- List of results of the text search with additional information about the find locations
- Can be called up directly in all the help languages available from the Internet or a local data medium.

**Benefit:**

*In addition to an up-to-date user interface the new help system can now be called up from different sources (local data medium / Internet). Calling up the help via an Internet connection also provides the possibility of always keeping the help system up-to-date.*

Some important and useful features of the previously used help format have been retained and continue to be available:

- Target-group oriented structuring of the help topics
- Context help to be called with [F1]
- Search possibilities via Table of contents, index, glossary and text search
Usage of the EPLAN Download Manager to install available help languages of local data media and in the network.

We discuss the following topics in the next sections:

- "New user interface elements" on Page "22"
- "Calling up the help system via an Internet connection" on Page "25".

New user interface elements

Some functionalities such as paging forward and backward and the favorites list have been taken over from the default functionalities of the Internet browser. Other user interface elements such as the toolbar of the help system have been redesigned. These changed and new elements are listed below.
Example:
The following figure shows the EPLAN help system opened in the Internet Explorer:

The figures have the following meaning: (1) Navigation area, (2) Toolbar, (3) Text search, (4) Button for hiding the navigation area, (5) Help topic with text area.

Navigation area
The "Navigation area" of the help window is displayed on the left-hand side of the help window. The tabs of this area – Contents, Index, and Glossary – provide different methods of access to the information contained in the help system.
## Dialog element

<table>
<thead>
<tr>
<th>Dialog element</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Hide navigation area" /></td>
<td>In order to hide the navigation area click this button on the right-hand margin of the navigation area.</td>
</tr>
<tr>
<td><img src="image" alt="Display navigation area" /></td>
<td>In order to display the navigation area click this button on the left-hand margin of the help window.</td>
</tr>
</tbody>
</table>

## Toolbar

The toolbar of the help system is located above the text area.

<table>
<thead>
<tr>
<th>Button</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Show all" /></td>
<td>This button opens and closes all the texts and images contained on a help page that can be expanded by clicking a header (for example <em>Dialog call, Example</em>).</td>
</tr>
<tr>
<td><img src="image" alt="Previous topic" /></td>
<td>Jumps to the previous page within the Table of contents. In order to return to the help page use the [Previous] button of the Internet browser.</td>
</tr>
<tr>
<td><img src="image" alt="Next topic" /></td>
<td>Jumps to the next page within the Table of contents. With this button you can very simply page through the help pages in the order of the Table of contents without having to click each entry in the Table of contents separately.</td>
</tr>
<tr>
<td><img src="image" alt="Print topic" /></td>
<td>Click this button to print the current help topic. The print dialog of the Internet browser is opened in which you can carry out further settings.</td>
</tr>
</tbody>
</table>
Text search

The text search is located on the top right-hand margin of the help window above the toolbar. It searches through all the pages of the help system for the search terms to be entered.

The search result of the text search is like that familiar to you from Internet search engines: As a result a list of the find locations is drawn up whose entries you can open by clicking. As a supplementary information a short text extract is displayed below the headline of the find location. This allows you to rapidly recognize which of the find locations fulfills your expectations.

<table>
<thead>
<tr>
<th>Dialog element</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Find&quot; input box</td>
<td>Enter one or more search terms in this box.</td>
</tr>
<tr>
<td>(Find)</td>
<td>Click this button to start the search for the entered search term.</td>
</tr>
</tbody>
</table>

The new format of the help system allows an extended text search with synonyms. A suitable search result is shown in many cases even when you enter similar or incorrect search terms or ones no longer used.

Calling up the help system via an Internet connection

The new help system is now additionally made available on an EPLAN web server. This means that you can call up the EPLAN help system via an Internet connection.

If this is not desired (because, for example, an Internet connection is not available), you can as in the past install the help system on a local storage medium.
The corresponding settings are carried out in the new settings dialog **Settings: Languages** by using the new **Help system** group box (menu path: **Options > Settings > User > Display > Languages**). If the help system is to be start via the Internet connection, activate the **Online** check box.

In the course of this extension the settings **Dialog language**, **Alternative language** and **Help system language** (now **Language**) which were located in the dialog **Settings: User interface** have been moved to this new settings dialog.
User Interface

Combination of selection and activation at filtering

In the EPLAN platform many dialogs (for example in the navigators) had the combination of a drop-down list for a filter with the associated check boxes for activating the filter. In Version 2.5 these two user interface elements have been combined as a simplification.

**Benefit:**

Through the combination of the two user interface elements for the filter the dialogs now require less space and have a better structure. The additional activation of a selected filter is no longer required. This simplifies the general handling of the filters in day-to-day-usage.

If you now select an entry in the Filter drop-down list, this filter is activated automatically. To deactivate a filter you can select the new entry "-Not activated-" in the list. This is almost everywhere the default entry for the Filter field that is initially displayed when the respective dialogs are opened. (Exceptions: Page navigator, dialogs for parts synchronization and master data synchronization. Here an activated filter is stored and is displayed when the dialog is opened again.)
Rapid toggling via the popup menu

In addition a popup menu with the following entries is available for the Filter drop-down list in the navigator dialogs:

- **Deactivate**: Resets the filter setting to the entry "- Not activated -".
- **Activate <Filter name>**: Reactivates the last active filter.

This popup menu allows you to toggle rapidly between the unfiltered representation and a representation filtered in accordance with your requirements.

Less Control Elements for More User-friendliness

For version 2.5., too, several settings, menu items, and functionalities have been removed from the program. Some of these functionalities can be carried out in other, much easier ways. Other GUI elements were completely removed since the associated functionalities were rarely used by our users or they made the EPLAN platform unnecessarily complex.

Each decision if a menu item should be removed was also influenced by the findings from our "customer-focused improvement program". Your participation makes it possible for us to continuously enhance user-friendliness and performance of the EPLAN platform!
Menu items

The following menu item has been removed in the Page menu:

- **Number supplementary fields**
  This rarely used functionality for numbering page supplementary fields has now been removed. To display a sequential page number, for example in the page properties, in the graphical editor or report pages, use the new page property **Counter page number** (ID 25020). This property automatically increments the pages in the project in accordance with the order in the page structure. You can insert this property as a special text in the editors.

  The property **Counter page number** has been added to various plot frames in the master data provided (see section "Master data: Forms and Plot Frames" (as of Page "142")).

The following menu items have been removed in the Project data menu:

- **Terminal strips > Correct**
- **Plugs > Correct**
- **Cables > Correct.**

These different menu items for correcting project data have been combined into one menu item. Use the menu items **Project > Organize > Correct** to open the dialog **Correct project** in which you can select a scheme with settings for correcting the project. For further information also refer to the section "Correcting project data" (see Page "45").
The following menu items have been removed in the Utilities > Automated Processing menu:

- **Run active script**
  As of Version 2.1 SP1, automated processing of projects is done using the EPLAN schemes technique. The obsolete technique of automated processing by means of project-specific scripts was initially still supported by the program, but has now finally been removed in Version 2.5. Correspondingly this menu item has also been removed.

- **Run**
  You now use the menu items Utilities > Automated processing to directly open the dialog Run: Automated processing and select a scheme for automated processing.

**Dialogs**

The following two dialogs have been removed from automated processing:

- **Settings: Automated processing** (Projects)
  As already mentioned, the obsolete technique of automated processing by means of project-specific scripts has been removed in this version. For this reason the corresponding project-specific settings dialog has also been removed.

- **Automated processing**
  The selection dialog Run: Automated processing for selecting a scheme is now displayed directly for this automated processing dialog, that you previously called up from the project management by using the menu items [Organize] > Automated processing. It remains possible to automatically process several projects by marking several projects beforehand in the project management tree.
Tip:
To continue using "old" scripts from previous EPLAN versions (Version 2.1 or previous), you can use the (Import script) button in the Settings: Automated processing dialog. Using a subsequent dialog, you can select a script file (*.cs) in the project directory of the selected project and save it as a new scheme.

In addition, the following dialog has been removed:

- Tip of the day
  The display of a single "Tip of the day" during the program start is no longer up-to-date - many users were bothered by the dialog called up and deactivated it. The dialog Tip of the day has therefore been removed. However, we wish to continue making tips for working with the EPLAN platform available. When you select the renamed menu item EPLAN Tips in the Help menu, a Help page with all the tips is now displayed. These tips are designed to help familiarize you with new functionalities and methods of working.
Graphical Editor

Oval text box

If ellipse-shaped text boxes are used for longer texts or visible device tags, representation problems may arise (overlapping of ellipse and text), because the ellipse is drawn into the rectangle surrounding it. In such a case you now have the possibility to set an oval text box.

**Benefit:**

*With the "Oval" setting ion you have more flexibility in laying out text boxes.*

If this setting is selected, the text is enclosed by an oval border. In the process the oval is drawn as a rectangle that is extended by two semicircles.

Analog to the other options for the text box you can carry out the settings both project-wide as well as individually at the respective text.

- **Project-wide** by means of an appropriate setting in layer management:
  The drop-down list of the **Text box** columns have been extended by the "Oval" entry. All the texts or device tags that lie on the respective level are surrounded by an oval frame project-wide.

- **Individually** by means of the corresponding properties dialog:
  In order to obtain an oval text box individually for a device tag or a text you can use the new "Oval" option in the property dialog on the **Display / Format** tab below the **Text box** hierarchical level for the **Draw text box** display property.
Improved positioning of texts

The Position hierarchy level has been added to the Format tab in the property dialog of the texts.

**Benefit:**

The display properties of the Position hierarchy level facilitate the exact positioning of texts (for example placeholder texts in forms) and allow you carry out detailed settings for docking texts.
The display properties displayed in this hierarchy level are the same as those you know from the Display tab of the components. The Base point display property that also occurs in the Position hierarchy level is not required for texts.

- **X-coordinate / Y-coordinate:**
  These two display properties can be used to specify the position of a text on a project page exactly. The coordinate specifications on the insertion point of a text are relative to the point of origin of the graphical coordinate system.

- **Docking / Centered:**
  With these display properties you can carry out the settings for docked texts. Such texts behave, for example, as a block when moved. The specification for the docking behavior of the docked texts are specified at a main text via the Dock specification display property. Through the Centered property you specify at a main text whether the block (i.e. main property + docked texts) is to be centered.

**Note:**
In the EPLAN platform texts can be docked and undocked via the menu items Edit > Text > Dock / ... > Undock. For further information on this topic please refer to the help system, for example in the section "Docking / Undocking Texts", and in the context-sensitive help of the Format tab.
Application of formattings for graphical elements

With the new version the [Apply] button is now also available in the property dialogs and the Format tab of graphical elements and texts. This allows you to successively adapt the formatting of this element with an opened property dialog while you follow the change in the graphical editor.

Correct Representation of Line Types

There are certain line types which contain additional graphics. These line types are mainly intended for usage in P&I diagrams.

- All the line types with additional graphics are now also represented correctly at oblique lines. The alignment of the additional graphic in relation to the line remains unchanged.

- At different scales of the page the line types are represented norm-compliant so that the line pattern can be recognized even at larger scales.
Example:

Example for a line type with additional graphic at an oblique representation.
Devices

Simplification and extension of the property arrangements
The property arrangement specifies the arrangement of the placed property texts and their display settings at a function. You have the possibility of creating own user-defined property arrangements. The user-defined property arrangements are saved project-specifically and are assigned to the symbol variant for which it was created.

In this version the editing possibilities of the user-defined property arrangements have been simplified and extended.

**Benefit:**

*Working with user-defined property arrangements is now simpler and more transparent. User-defined property arrangements can be assigned faster and more comfortably, for example by multiple selection at editing in a table or at external editing. The user-defined property arrangements are now also taken better into consideration when working with macros. User-defined property arrangements offer you extensive possibilities to arrange the display of information in the schematic individually and thus make your documents both well structured and informative.*

Simplified behavior for changing and importing
The behavior when changing and importing property arrangements has been simplified:
If you save a user-defined property arrangement under an existing name, the changes are now automatically transferred to all the functions that use this property arrangement. The name of the user-defined property arrangement remains unchanged at all the affected functions in the process. The selection option of transferring the changes only to the current function no longer exists.

This behavior also applies to the importing of property arrangements. If you overwrite one or more property arrangements during importing, the changed display settings are also transferred automatically to those functions that use these property arrangements.

In a layout space the behavior described above for functions applies correspondingly for the part placements.

**Extended editing possibilities**

You can now assign user-defined property arrangements at the following points in the program:

- When editing functions in tables you can display the **Property arrangement** column and select a property arrangement from the drop-down list. The list contains all the property arrangements that are available for the respective symbol variant.

- When you create schemes for external editing, you can select the property arrangement in the dialog **Settings: External editing** as a format element and thus include the corresponding data during exporting and importing.
You can use the **Property arrangements** (ID 19307) property in the properties dialog of placeholder objects and assign the user-defined property arrangements as value sets through a variable. The corresponding property arrangements have to exist in the project to this purpose.

You can also assign existing property arrangements through a user-defined button in the toolbar. To do so use the **Customize** dialog to select the action `XEsSetPropertyAction` and use the ID 19307 of the **Property arrangement** property as the value for the `PropertyId` parameter.

**Modified behavior during copying and pasting and when inserting macros**

When copying and pasting pages or functions and when inserting macros the names of the property arrangements were not retained in the past. The inserted property arrangements were always changed to "User-defined". As of the current version this behavior was changed as follows:

The user-defined property arrangements are compared when copying and pasting pages or functions into a different project or when inserting macros. The name of the property arrangement at the function is retained if the property arrangements are identical or if the property arrangement does not yet exist in the project. In this case the property arrangement is generated.

The new project setting **Apply property arrangements from the project** is available for the case that a property arrangement with the same name already exists in the project and is not identical with the property arrangement at the functions. (The menu path for the settings dialog is: **Options > Settings > Projects > "Project name" > Graphical editing > General**.)
If this check box is activated, the property arrangement from the project is transferred to the inserted function and the name of the property arrangement is retained at the function.

If the check box is deactivated, the property arrangement at the inserted function is retained and the name is changed to "User-defined".

**Reset property arrangements**

If required, you can simply reset the user-defined property arrangements to the default - also for several functions simultaneously. The new menu item **Reset property arrangement** is available to this purpose in the menu path **Edit > Text**.

You can use this menu item after you have marked one or more functions with user-defined property arrangements in the graphical editor or in a project data navigator. Or after you have marked one or more part placements in a layout space. The property arrangement is reset to the default setting for the marked functions / part placements. This is either the setting "Default setting" or the property arrangement that you have specified as the default.
For more information on this topic please refer to the help system in the section "Using User-Defined Property Arrangements".

Extended automatic coordinates for property arrangements

As of Version 2.4 the setting "Y coordinate automatic (path)" has been added to the display property **Base point**. This setting allows you to display the placed properties of a component path-wise below the drawing (Y coordinate fixed, only X-coordinate can be changed).

As a completion and in order to take other standards (NFPA, JIC) into consideration this functionality is now also available for the X coordinate and for numerous further components. This setting can also be used for the graphical representation of automation schemes in building automation.

**Benefit:**

*Working with automatic coordinates is now consistently possible for all the relevant components in the platform and simplifies the representation of texts to various standards.*

Setting in the display properties is now no longer carried out via the base point, but rather by means of two new display properties **Y-coordinate automatic (path)** and **X-coordinate automatic (path)**. The respective check box has to be activated so that the placed properties take into consideration a coordinate automatically entered in the page or plot frame properties.
Using the **Y coordinate automatic (path)** setting, the placed properties of a component can be displayed path-wise below the drawing. If the check box is activated, only the X coordinate of the base point is still taken into consideration when placing the property text, while the Y coordinate is specified automatically. The value of the Y coordinate (in relation to the origin of the page) is determined in the **Property arrangement: Y coordinate automatic (path)** (ID 12062) property. This property is available for plot frames and pages.
Using the **X coordinate automatic (path)** setting, the placed properties of a component can be displayed line-wise next to the drawing. This is for example of interest for projects to the NFPA standard. If the check box is activated, only the Y coordinate of the base point is still taken into consideration when placing the property text, while the X coordinate is specified automatically. The value of the X coordinate (in relation to the origin of the page) is determined in the **Property arrangement: X coordinate automatic (path)** (ID 12063) property. This property is available for plot frames and pages.

You can move the position of a placed main property relative to the base point as well when automatic coordinates are used. If you have activated one (or both) of the settings **X coordinate automatic (path)** or **Y coordinate automatic (path)**, the entries in the fields **X coordinate** and **Y coordinate** always reference the base point that has already been moved by the automatic coordinate.

**Tip:**

In order to arrange several property texts with automatic Y coordinate in the form of a list in a schematic path enter a different value in the **Y coordinate** field. The property texts are then moved relative to the automatic Y coordinate.

In order to achieve an arrangement in the form of a table enter different values respectively in the fields **X coordinate** and **Y coordinate**.

For further information on this topic, please refer to the help system in the section "Display Properties: Placed Property".
Project Editing

Update the project databases

As part of miscellaneous extensions and optimizations, the project databases have been changed in Version 2.5. These modifications and optimizations make it possible to create new projects essentially with new project databases.

Consequences for legacy projects

In order for old projects to be edited in the new EPLAN version, updating of the project databases is absolutely essential for these projects. Old projects are updated the first time they are opened with the current EPLAN version. At the time, you will be prompted whether you wish to import the project in the current version.

If you confirm with [Yes], the project is first updated and then opened. In addition, a backup copy with the not-updated project databases is created in the project directory.

If you do not update an old project, you will still be able to open this project in the version 2.5, but you can only view it, and not edit it.

⚠️ Caution:

New projects and old projects that have been updated and edited can be opened with the EPLAN Version 2.4. Due to the extensions to Version 2.5 this can result in an incorrect display at specific data. Older EPLAN versions (prior to version 2.4) cannot open the updated projects anymore!
New file format for backup copy

When updating a project a backup copy with project databases that have not yet been updated is created additionally. In the past these backup copies were stored as editable projects (*.elk). This meant that a current project directory could become very unstructured.

With the new version the backup copies are now saved as backup files (*.zw1). These files are always zipped (using the 7-Zip program) and are no longer displayed in the project directory when projects are opened. The projects can be restored by using the data backup program – as is usual for data backups.

Correcting project data

Several existing functionalities for correcting project data (terminal strips, plugs, cables) have been combined into a new settings dialog as of this version.

益: Thanks to the combining of the various correction functionalities you can now automatically correct different project data through a single correction run.

In order to execute the correction run select the new menu item Correct in the menu path Project > Organize. In the dialog then opened Correct project use a scheme to specify which project data are to be corrected. In the dialog Correct project select the desired scheme or use the [...] button to branch to the new dialog Settings: Correct.
All the correction settings – previously distributed amongst various dialogs – are now available as check boxes in the new dialog **Settings: Correct**. The "old" menu items for terminal strips, plugs, and cables existing in the **Project data** menu have been removed. (In order to access these correction settings in the settings dialog, select the menu path **Options > Settings > Projects > "Project name" > Management > Correct.**
New correction for connection symbols

In addition, the new setting Correct connection symbols outside a defined network (activate 'Specify targets') is now available in the settings dialog in the Connections hierarchy level. When this setting is activated, the check box Specify targets is activated again at all connection symbols (T-nodes, double junctions, jumpers) that no longer lie in a defined network.

This is of interest, for example, at the definition of nets for net-based connections when net definition points have been removed manually and the changeover at the associated connection symbols has been forgotten.

Tip:

In order to delete all the net definition points in a project, you can use the project compressing function. To this purpose activate the new check box Remove all net definition points and correct connection symbols in the dialog Settings: Compression of the Net definition points hierarchy level. In the process all the associated connection symbols are changed automatically (the check box Specify targets is activated).

Utilization of the non-norm-compliant structure setting "Superior"

In the past the Superior check box in the Structure tab of the project properties allowed you to specify for specific devices (terminal strips, plugs, cables or interruption points) that these devices be treated as sequentially-numbered devices if no "-" preceding sign is contained in the DT. This is not norm-compliant for a project structure with specified identifier blocks (for example higher-level function, mounting location) and is only contained in the program for historical reasons.
Since this setting will no longer be supported by EPLAN in future, the *Superior* check box will only be displayed in the following cases:

- **"Superior" setting is not yet used in the project:**
  To display the setting activate the new setting *Allow structure setting 'Superior' that is not norm-compliant* in the dialog *Settings: Compatibility* (menu path: **Options > Settings > Projects > "Project name" > Management > Compatibility**). For the reasons mentioned above we recommend that you do not do this.

- **"Superior" setting is already being used in the project:**
  The *Allow structure setting 'Superior' that is not norm-compliant* check box is grayed out, meaning that it cannot be deactivated.

**No effects on old projects**

This setting remains unchanged in old projects (Version 2.4 and previous) in which the setting *Superior* was used. If you open such a project in Version 2.5, the new check box *Allow structure setting 'Superior' that is not norm-compliant* is activated automatically.

This check box is deactivated by default for *new projects*.

**New message**

The new check run message 017013 is now available in the message class 017 "DT" in order to find out whether the *Superior* structure setting was used in a project.
Defined Devices

Modules for differing device identification standards

Modules form one of the possibilities in the EPLAN platform of mapping complex devices. Modules have the same properties as parts, but additionally contain lists of subparts. In the past the assignment of the subparts in the module to the devices in the associated macro was carried out via the subordinate device tags of the devices. If the device tags had to be adapted to customer requirements or if the identifiers changed due to differing standards, you had to create both differing module parts as well as differing macros that only differed in the device tags.

You can now use a so-called "Module ID" for the identification of the devices so that the synchronization between the parts in the module and the devices in the macro can be effected independently of the used device tags.

Benefit:

Modules that use the Module ID to identify the subordinate device components can now be used independently of the identification standards used. This greatly reduces the amount of work required for the creation of the modules and the associated macros.

Specification of the module ID at the device

The specification of the module IDs at the devices is carried out in a macro to be created for a module. Enter the respective identifier, that has to be unique within a macro / module, in the property dialog in the properties table on the first tab. The new Module ID (ID 20359) property is available in the property selection to this purpose.
Extension to parts management

The definition of modules is carried out in the parts management in the Module tab. The Module ID was added to this tab for the entry of the module ID. Either an entry in the DT column or in the Module ID column is possible for the part of a module (i.e. per line). If you carry out an entry in the Module ID column, the entry for the subordinate DT in the same line is deleted and vice versa.

Targeted display of the module ID

You can use the new property Module ID in the device navigator as a filter criterion for the targeted display and editing of functions with module IDs and display it as a column in the list view of this navigator.

In addition, the module ID of functions can also be displayed and edited in the table display format. To this purpose you have to use a scheme to implement a corresponding column configuration for the Functions tab of the Edit function data dialog.

New check run for devices

The module ID has to be unique within a macro. In order to check this during the creation of macros the new check run message 007025 "The module ID "%1!s!" has been assigned several times." is now available in the message class 007 "Devices".
Extensions for device groups
Complex devices can also be realized by means of a device group in the EPLAN platform. Functions from different trades and devices tags can be grouped graphically and logically into one device. Many users use this, for example, to group fluid power devices with electrical-engineering components and save the functions that have been combined as a device group subsequently as macros.

Menu items for device groups
In view of the increased focusing of the EPLAN platform on the processing preparation of macros, the creation and ungrouping of device groups has been changed for this version:

- The creation of device groups by means of the menu items **Edit > Other > Group device** is now only still possible in **Macro projects**. The menu item **Group device** is inactive in schematic projects.

- The grouping of a device group can now also only be ungrouped in a **macro project**.

Note:
In schematic projects you can use the menu items **Edit > Other > Ungroup** only still to ungroup the grouping of element groups (i.e. a grouping of graphical elements).

Device groups without placement
The placing of a selected device group can now be deleted completely by using the menu items **Edit > Delete placement**. It is irrelevant whether the deleting of the placement is carried out in the device navigator or in the graphical editor.
Unplaced device groups now behave just like other unplaced functions and can, for example, be placed from the navigator in the graphical editor.

Project Data Navigators

Uniform behavior during placing and inserting devices

The functionalities "Place", "Place macro" and "Insert device" were standardized for this version of the EPLAN platform. In the course of these changes the popup menu of most of the navigators was reduced and simplified. Instead of the two popup menu items Place and Place macro that each branched to a follow-up menu with several representation types, the popup menu item of these navigators now only disposes of the popup menu item Place (without follow-up menu).

Irrespective of the means by which you want to place functions / part macros or insert devices, the program automatically uses the representation type that suits the respective page type.

**Benefit:**

Both during the placement of existing functions as well as when inserting devices the EPLAN platform now automatically offers the part macros and functions suitable for the page type without your having to deal intensively with the selection. The standardized and intuitive handling facilitates working with the navigators as well as inserting devices.

In the process the part macro has the highest priority – both during the inserting of devices as well as during placing. If no part macro is stored at the selected device or at the main function, insert individual functions or place it.
Other selection during placing or inserting of devices

If you want to carry out a different selection instead of the preselection automatically carried out by the program (for example place a different macro), press [Backspace] before placing or inserting. In the dialogs then opened **Place device** (at placing) or **Insert device** (when inserting devices) you can choose between different options.

The dialogs display a logical presetting in accordance with the respective situation. For example the representation type suitting the page type is then selected.

If the parts master data are maintained insufficiently (meaning that neither a macro nor function templates exist at the selected part), the **Insert device** dialog is opened immediately when devices are inserted. In such a case only a macro or symbol selection is possible.
Other customization

In the course of these standardizations the following changes have furthermore been carried out:

- In the bill of materials navigator and in the device list:
  The popup menu item Place via has always corresponded to the insertion of devices. For this reason the popup menu item has been renamed to Insert device (without follow-up menu).

- In the part master data navigator:
  The popup menu item Insert device that forced the selection of a representation type through follow-up menus has been replaced by a menu item with the same name without follow-up menu.

Bill of Materials Navigator

Assigning item numbers structure- or page-specifically

The item numbers of parts can now be assigned in accordance with the identifier structure or the page structure. To this purpose the new field New numbering at changed property has been added to the dialog Number items. You open this dialog by marking the items to be numbered in the bill of materials navigator and selecting the popup menu item Add item numbers.

**Benefit:**
The item numbers of parts can be assigned structure- or page-specifically in the bill of materials navigator. After numbering the item numbers of the parts are written back to the functions and can be displayed in the graphical editor or be output in reports.
Select an existing scheme from the drop-down list in the New numbering at changed property field, or use [...] to open the dialog New numbering at changed property. You can edit existing schemes or create new ones there. Such a scheme can be used to assign the item numbers structure- or page-specifically. To this purpose you can select, for example, the properties Higher-level function or Page name as criteria. If a value of the properties specified in the scheme changes (for example the structure identifiers for the higher-level function), numbering begins again with the starting value specified in the dialog.

**New property "Item number list"**

If several parts are assigned to one function, the Item number list (ID 20346) property displays the item numbers of all the parts separated by commas. This property allows you to display the item numbers of the parts at the functions in the graphical editor or output them in reports.
External editing

Extended functionality of path function texts
During external editing it is now possible to export the path function texts of a project, to edit these externally and import them again. As is usual in external editing, exporting of the path function texts is carried out by means of schemes. The new entry "Path function texts" is available in the dialog Object type for the corresponding schemes.

Format elements
You specify the data to be included in external editing as usual in the dialog Settings: External editing on the Data tab. You can, for example, select the following properties as a format element for the "Path function texts" object type:

- **Text contents** (ID 19201):
  The contents of the path function texts are output by means of this selected format element. Only this format element can be changed.

- **Placement** (ID 19007):
  This format element supplies the complete placement of the respective path function text.

- **Affected functions** (ID 19800):
  New property! This format element lists all the functions for a path function text that adopt this function text from the path.

If you use the "Affected functions" format element, the individual functions for a path function text are separated in the target file are separated by a slash "/" (with preceding and subsequent blank).
The new function property **Name (complete with connection point designations)** (ID 20342) is reported internally for the output of the functions. This property is composed as follows: Property **Name (full)**, ":" and the property **Connection point designations (all)** (e.g. =EB3+ET1-X0:L1).

### Reports

#### Changes in the user interface

The dialog **Reports** was adapted to the "common style" of the EPLAN platform for Version 2.5. The buttons that existed in the two tabs **Reports** and **Templates** of the dialog have been removed. Instead, these and further functionalities are now available as buttons in toolbars that are located above the respective tree view.
Parts Management

Update the parts database

If you work with several EPLAN versions (e.g., when switching to version 2.5) and have in version 2.5 an "older" parts database, you will be prompted upon opening parts management to update the parts database. If you answer this prompt with [Yes], the parts database is updated.

If you click [No], then the parts database is not updated. The parts management data fields will then remain empty and cannot be edited.

Other program features which also access the data in the parts database will output an equivalent message if the parts database does not correspond to the current version.

Note:

If you work with several EPLAN versions, then we recommend using the latest EPLAN version when editing and managing the parts database. An updated parts database can be opened in older EPLAN versions, for example, to select parts or devices, but cannot be edited.

Offset for connection point pattern

You can now define an offset for the connection point pattern stored at a part.

Benefit:

The offset defined by using the Offset in X-direction and Offset in Y-direction fields allows you to use identical connection point patterns for several parts having different sizes.
To this purpose the **Connection point pattern** field on the **Technical data** tab has been converted into a group box. In the two new additional fields **Offset in X-direction** and **Offset in Y-direction** you specify an offset in the X- and Y-directions respectively for the respective connection point pattern. The X- and Y-offsets are stored per part. They are therefore identical for all variants of a part.
Settings

Uniform settings for databases
The procedure and the settings for creating new databases have been simplified for this version. Analog to the existing settings for the project management database, it is now also possible to create a new database / dictionary directly in the settings for the parts management and the dictionary. To do so, click the (New) button for the respective option (Access or SQL-Server). Depending on the selected option a new Access or SQL database is created.

In the course of this standardization the following menu items became superfluous:

- in the dialog Parts management the menu item New database under the [Extras] button was removed.
- In the dialog Dictionary the menu item New below the [Extras] button on the Management tab was removed.
Application of Settings

With the new version the dialog for editing all the settings now also has an [Apply] button. This allows you to save your settings without having to close the settings dialog via [OK]. This can, for example, be helpful in exporting settings.

Utilities

Optimization of the system message management

The previous technique of storing system messages in a text file has proven to be no longer up-to-date. The system messages are now stored in a database therefore. In the course of this revision some changes were also carried out in the user interface.

**Benefit:**

*The optimization of the system message management also results in improved usability of the system messages. For example, the messages of several sessions or messages from previous sessions can now also be displayed. Thanks to the access to older messages you can now, for example, check whether a specific error has already occurred in the past.*

An overview of the new features at the system messages:

- **Storing of the system messages in a database:**
  As of Version 2.5 the system messages are saved automatically in a database called EplLog.eldb. The system message file that was used in the previous versions to save the system messages is no longer required.
Display of the system messages of all the sessions:

Not only messages of the current session can be displayed, but also the messages of previous sessions. By default the program shows the system messages of the current session. Through the Display all sessions check boxes it is possible to extend the list of system messages and to have the messages of the previous sessions listed.

The messages of a session are displayed in the dialog System messages below a separate node (new icon 🪜).

Opening the system messages of a different database:

In the system message dialog you have the possibility to access any other system message database and to have its contents displayed (for example a database from previous sessions). The menu item Open is available to this purpose below the [File] button in the dialog.

Exporting the system messages:

You can export the contents of the database from the system message dialog into a file of the type *.csv. The database export is started via [File] > Export. Subsequently start the application that is linked with the file type *.csv. For example, you can use MS Excel to have the messages displayed. In this application you can use the full-text search for error analysis.

For further information about the system messages, please refer to the help system in the section "System messages".
New Features in the "EPLAN Multi-User Management" Extension Module

Note:
The "EPLAN Multiuser Management" extension module is available as an optional extra for the following programming variants:
For the following program variants, this extension module is part of the delivery scope by default: EPLAN Electric P8 Ultimate.

Using the "EPLAN Multi-User Management" extension module, you can divide projects into so-called "defined working sections". This makes the display of large projects more transparent and increases the editing speed. If external persons are to be used for editing extensive projects, or if editing is to be carried out independently of a network connection, you can additionally use the functionality to divide these projects into several subprojects.

Simplified activation of defined work sections
In order to define and use defined working section, you first had to carry out an activation of the selection of defined working sections in the project properties in the past. In the new version activation is now carried out by using the menu items Project > Defined working sections > Activate selected defined working section.
In the course of this simplification the tab **Defined working sections** in the project properties that was used in the past to set the activation of defined working sections has been removed.

The selection and definition of defined working sections in a project has also become simpler. The two menu items **Define** and **Define as project administrator** are now always available – irrespective of whether the activation of defined working sections is activated or not.

**New Features in the "EPLAN Revision Management" Extension Module**

*Note:*

The "EPLAN Revision Management" extension module is available as an optional extra for the following programming variants:

- EPLAN Electric P8 Select, EPLAN Preplanning P&ID.
- For the following program variants, this extension module is part of the delivery scope by default:
  - EPLAN Electric P8 Professional, EPLAN Electric P8 Professional+,
  - EPLAN Electric P8 Ultimate, EPLAN Fluid, EPLAN Fluid Professional,

Via Revision control, the "EPLAN Revision Management" extension module, modifications of existing machine and plant documentation can be detected and documented automatically.
Revisioning defined working sections

The Change tracking function can be used to revision sections of a project. The sections to be revisioned are defined through the defined working sections. Changes in the individual defined working sections are documented and protected independently of each other.

**Note:**

In order to revision sections of a project you must have the possibility to define defined working sections. The definition of the defined working sections is available in the "EPLAN Multiuser Management" extension module.

**Benefit:**

Changes in individual sections of the project structure, in individual trades, etc. can be revisioned, documented and protected independently of each other by means of the defined working sections.

Revisioning of defined working sections is carried out page-by-page. This means that you have to use properties for structure identifiers (for example Higher-level function and mounting location) or page properties (for example Page name) as filter criteria when defining defined working sections. This allows sections of a project structure or individual trades to be revisioned separately. In order to revision trades the project has to be structured so that all the pages of a trade are allocated uniquely to a specific page structure.

**Preconditions**

The following requirements must be fulfilled so that a defined working section can be revisioned:
- The project itself may not have been revisioned.
- The defined working section may not overlap a different defined working section.
- The defined working section must have been selected and have been activated by using the menu items Project > Defined working sections > Activate selected defined working section.

Procedure and user interface changes

The procedure for revisioning activated defined working sections is the same as for revisioning "complete" projects. Through the menu item or completing projects you can now also complete revisioned defined working sections. The menu item has been renamed correspondingly to Complete project / section. The Defined working section field has been added to the following dialogs in order to display the currently active defined working section:

- Dialog Generate revision
- Dialog Description of page modification when completing pages
- Dialog Complete defined working sections. (This dialog is displayed during the revisioning of defined working sections. Otherwise it is the same as the dialog for completing projects.)

The Defined working section column has been added to the following dialogs:

- Dialog Edit revision data
- Dialog Deleted pages.

This column lists the defined working sections for which pages / layout spaces were modified or pages deleted during a specific revision.
Change protection for completed defined working sections

When you complete a defined working section, the associated pages or layout spaces have an automatic change protection assigned to them.

This protection can be removed in the usual manner in the revision for a selected defined working section (menu item Remove write protection). In the dialog Configure protection you additionally have the possibility to temporarily deactivate the automatic change protection for correction purposes for selected pages or layout spaces.

New Properties

In addition the following new indexed properties exist.

- Project property Defined working section (from change tracking) [1-1000] (ID 10195)
- Page property Defined working section (from change tracking) [1-1000] (ID 11079).

After the revision these properties show the corresponding scheme name of the defined working section. This allows you, for example, to recognize the revision status of the individual defined working sections in the project properties. You can, for example, use the new page property as a filter criterion for the page navigator. By this means the entire project or the selected defined working section can be filtered for those pages that were changed at a specific revision (for example Index 2) of a defined working section.

Changes in the definition of defined working sections

When you carry out a revision for a defined working section, the name of the current revision is now displayed in the new column Revision in the dialogs for defining the defined working sections.
Revisioned defined working sections and subprojects
You cannot file off revisioned defined working sections in the dialog Sub-projects.

Controlling the application of revision data during inserting
If you insert copied pages or page macros from a revision project into another project, the revision data from the revision project can now optionally be retained or deleted. The desired behavior is specified by using the user setting Retain revision data during inserting (menu path: Options > Settings > User > Display > General.)

This new check box is activated by default. This means that – as in the past – the revision data from the source project are inserted into the target project when copied pages or page macros are inserted.

If the check box is deactivated, no revision data are inserted into the target project. The revision data of the copied pages or page macros are deleted during inserting.

For further information on this topic, please refer to the help system in the section "Revision Control: Principle".
New Features in the "EPLAN User Rights Management" Extension Module

Note:
The "EPLAN User Rights Management" extension module is available as an optional extra for the following programming variants:
For the following program variants, this extension module is part of the delivery scope by default:

Through the "EPLAN User Rights Management" extension module, the rights management, an administrator can configure both the user rights and the user interface (dialogs, menu structure, etc.) of the EPLAN platform.

The following innovations have resulted in the rights management for the current version:

- The rights of the "ADMINISTRATOR" user group are now updated automatically for each EPLAN version. Therefore the menu item [Extras] > Update rights in the dialog Rights management is no longer required and has been removed for this version.

- Importing of a rights database from a previous EPLAN version is now called up via the new button [Import]. Select the desired database file in the subsequent dialog. Possible file types are "Rights database in EPLAN format (*.erm)" and "Rights database in Access format (*.mdb)".
New Features for EPLAN Electric P8

Terminals

The internal management of the multi-level terminals has been revised in this version. Terminal devices (such as multi-level terminals) are supported better and are retained during project editing. To this purpose a so-called "device position" has been introduced as a new property for terminals. The clarity in the terminal strip navigator has been increased through a new device-oriented view.

**Benefit:**

*Due to the enhanced and clearly arranged management, multi-level terminals can now be designed faster. The copying or subsequent revising of existing terminal strips is now a lot easier, too.*

The clarity has also been improved for the Edit terminal strip dialog – for example a scheme-like graphical preview of the terminals makes it easier to recognize different terminal types. In addition this dialog no provides the possibility to store the column configuration in a scheme. In addition, the following extended editing capabilities are now available there.

We discuss the following topics in the next sections:

- "New property "Device list"" on Page "71"
- "Device-oriented View in the Terminal Strip Navigator" on Page "72"
- "Improvements in editing terminals" on Page "73"
- "Simplified working with manual saddle jumpers" on Page "78"
New property "Device list"
Terminal devices (for example multi-level terminals) are now identified through the new property **Terminal: Device position** (ID 20367). All the terminals of a terminal device have the same device position.

In the past the sequence of the terminals within a terminal strip is specified through the sort code. Now the sequence is specified through the device position. The device position specifies the position of the terminal device within the terminal strip to which the terminal belongs. The sorting code specifies the sequence of the terminals within a terminal device. This means that the sort code is only still relevant for the terminals with the same device position.

**Benefit:**

*Terminal devices are retained during copying and pasting. If, thus you copy, for example, individual terminals that belong to different multi-level terminals, the original definitions of the multi-level terminals are retained.*

The device position and the sort code are *assigned automatically* if this is necessary, i.e. if terminals with a device position and / or sort code already exist for the same terminal strip. This ensures that new terminals are always sorted in to the end of the terminal strip and existing terminal devices as well as the existing sequence of the terminals are not changed. If required, you can enter the properties **Terminal: Device position** (ID 20367) and **Sort code (terminal / pin)** (ID 20809) but also manually in the property dialog of the terminal.
The device position and the sort code are assigned automatically at the following actions – if required:

- Editing the terminals in the dialog **Edit terminal strip**
- Sorting of terminals
- Generation of new terminals and multi-level terminals
- Inserting a device (a device position is *always* inserted in the process)
- Copying and pasting of terminals with online numbering
- Inserting of macros
- Opening of projects that were created by means of previous EPLAN versions (Version 2.4 or older).

**Device-oriented View in the Terminal Strip Navigator**

The new view "Device-oriented" is available in the tree view of the terminal strip navigator. This view can be activated through the popup menu item **View > Device-oriented**. The terminals are grouped in accordance with their device position, meaning that terminals with the same device position are summarized into a terminal device (for example a multi-level terminal).

**Benefit:**

*In the terminal strip navigator you can now recognize immediately through the device-oriented view which terminals belong to which terminal device (for example to a multi-level terminal). You no longer need to change to the Edit terminal strip dialog to see where the terminals belong to.*

In the context of this extension the previous DT-oriented default view has been renamed to "DT-oriented". It can be activated through the popup menu item **View > DT-oriented**.
Improvements in editing terminals

One of the central dialogs for the editing of terminals is the Edit terminal strip dialog. Here all the settings and data for the selected terminal strip are displayed. In this version this dialog has been extended with new useful columns, the column configuration via scheme technology and the possibility of generating multi-level terminals program-supported.

Scheme for column configuration and new columns

In the past you could carry out the column configuration in the Edit terminal strip dialog via the popup menu item Configure representation. With the new version the displayed columns and their sequence are now stored in a scheme.

To this purpose the dialog contains the new field Scheme. Here you select a scheme from the drop-down list to define the settings. Click [...] to open the dialog Settings: Column configuration. There you can edit existing schemes or create a new scheme.

**Benefit:**

The fact that you can store the configurations for different editing cases as schemes means that you can switch rapidly and simply between various representations of the terminal strips. The new schematic preview of the terminals makes it easier, among other things, to recognize different terminal types, potential types and multi-level terminals.
Several new columns are available for display in the column configuration:

- **Preview**: You can show the **Preview** column in order to display a schematic preview of the terminals. The preview is also contained in the default configuration. Among other things the number of connection points, saddle jumper option, terminal category, etc. are illustrated by graphics. The potential types are illustrated by different colors. The levels of multi-level terminals are represented indented.

- **Connection properties**: You can now display various connection properties of the connections that are connected to the terminals as columns. These properties, for example the **Connection color / number** or **Connection cross-section**, can be displayed separately for the external and internal sides of the terminal.

- **Part number**: You can display up to ten parts assigned to the terminal in the columns **Part number [1] - Part number [10]**. A part selection is possible through the [...] button within a field.

In addition, the fields **Level**, **Connection point cross-section** and **Function definition** that in the past served only to display the data and were therefore grayed-out, can now be edited. When changed, the corresponding data are written back to the schematic.
Example:

The following illustration shows a possible column configuration for the dialog **Edit terminal strip** with the new columns **Preview**, **Connection color / number (external)** and **Part number** [1].

Tip:

You can now simply sort terminals in the **Edit terminal strips** dialog by dragging-&-dropping them. To do so mark the row number of the desired terminal and move it to the correct position by dragging-&-dropping it. Multiple selection of terminals is also possible.
New buttons for multi-level terminals and manual saddle jumpers

The following new buttons are available for generating multi-level terminals as well as for generating and deleting manual saddle jumpers in the **Edit terminal strip** dialog:

<table>
<thead>
<tr>
<th>Button</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Generate multi-level terminal" /></td>
<td>(Generate multi-level terminal) Generates a multi-level terminal from the marked terminals. In the process the levels are assigned automatically in descending order. The terminal with the highest level becomes the main terminal.</td>
</tr>
<tr>
<td><img src="image2" alt="Disconnect" /></td>
<td>(Disconnect) Disconnects terminals belonging together (e.g. multi-level terminals) or terminals and associated accessories. Only the marked rows are disconnected. It is only possible to move one level of a multi-level terminal to a different terminal if the multi-level terminals are split.</td>
</tr>
</tbody>
</table>
| ![Generate manual saddle jumper (external)](image3) ![Generate manual saddle jumper (internal)](image4) | (Generate manual saddle jumper (external)) (Generate manual saddle jumper (internal)) Generates a manual saddle jumper between the marked terminals.  
  - **External:** Generates a manual saddle jumper between the external saddle jumper connection points.  
  - **Internal:** Generates a manual saddle jumper between the internal saddle jumper connection points.  
  The respective button is only active if the marked terminals dispose of a corresponding saddle jumper option. If manual saddle jumpers are already defined for some terminals within the marking, the saddle jumpers are - where possible - combined into a continuous saddle jumper as well as additional nodes to the existing saddle jumper inserted. |
(Delete manual saddle jumper (external))

<table>
<thead>
<tr>
<th>Deletes an existing manual saddle jumper between the marked terminals.</th>
</tr>
</thead>
<tbody>
<tr>
<td>▪ External: Deletes a manual saddle jumper between the external saddle jumper connection points.</td>
</tr>
<tr>
<td>▪ Internal: Deletes a manual saddle jumper between the internal saddle jumper connection points.</td>
</tr>
</tbody>
</table>

The generation and deleting of manual saddle jumpers is now effected through the corresponding buttons. The popup menu item Manual saddle jumper with which a manual saddle jumper between the marked terminals could be generated or deleted in the past has been removed. The Split popup menu item has also been replaced by a corresponding button.

**Defining multi-level terminals with program support**

Multi-level terminals can now be defined with program support. The new button 🌦️ (Generate multi-level terminal) is available to this purpose in the Edit terminal strip dialog.

**Benefit:**

You can combine terminals simply and comfortably into multi-level terminals. The multi-level terminals thus generated are retained during copying actions. Automatic rules are no longer used to specify which terminals are combined into a multi-level terminal.
The selected terminals are combined into a multi-level terminal through this button. In the process the levels are assigned automatically in descending order. The terminal with the highest level becomes the main terminal.

You can also combine selected terminals into a multi-level terminal in the graphical editor or the terminal strip navigator. To do so select the menu items **Project data > Terminal strips > Generate multi-level terminal**.

For further information on this topic, please refer to the help system in the section "Defining Multi-level Terminals".

**Simplified working with manual saddle jumpers**

In this version working manual saddle jumpers has been simplified. In the past you could define manual saddle jumpers both in the **Edit terminal strip** dialog as well as at the individual terminals. Now you specify manual saddle jumpers more comfortably by using special buttons in the **Edit terminal strip** dialog.

**Benefit:**

*Manual saddle jumpers can now be generated and edited more simply and comfortably. Manual saddle jumper formation between different levels is now supported better.*

To this purpose the setting options for manual saddle jumpers in the property dialog have been removed from the drop-down list of the **Saddle jumper** field and additionally the **Manual saddle jumper** popup menu item removed from the **Edit terminal strip** dialog.
You can now recognize in the **Edit terminal strip** dialog whether a terminal disposes of a saddle jumper option. A graphic (small dot) indicates whether the terminal disposes of at least one external / internal saddle jumper connection point in the columns **Saddle jumpers (external)** and **Saddle jumpers (internal)**.

The settings for a manual saddle jumper are stored at that terminal that represents the jumper start. To this purpose the terminals dispose of the new properties **Manual saddle jumpers (internal)** (ID 20350) and **Manual saddle jumpers (external)** (ID 20351). The "jumper crest" is defined in these properties. To this purpose the increment to the next jumpered terminals is specified as well as the increment to the associated level starting from the jumper start. This means that the entire jumper is defined at that terminal that represents the jumper start, and no longer by the saddle jumper settings at the individual terminals involved.

An example and further information about the manual saddle jumpers are available in the help system in the section "Using Jumpers".

New Features in the "EPLAN FieldSys" Extension Module

Note:
The extension module "EPLAN FieldSys" is available as an option for EPLAN Electric P8 Select, EPLAN Electric P8 Professional, and EPLAN Electric P8 Professional+. This extension module is part of the default scope of delivery for EPLAN Electric P8 Ultimate.

You can plan routing path networks in a topology by using the extension module. Such routing path networks are used to route connections, such as cables, conductors, and wires. This way, you can generate reports, on the basis of the routing path networks, for graphical, possibly properly scaled overviews of a machine shop, a plant, etc.

Various extensions were carried out for the topology for Version 2.5. Some of these extensions support you, for example in creating schematics in accordance with the GOST standard.

In the context of these changes corrections were also carried out in the representation of line types (see Page "35") and extensions to the assignment of item numbers in the bill of materials navigator (see Page "54").

We discuss the following topics in the next sections:

- "Routing of single-line cables" on Page "81"
- "Consideration of Height Differences during Routing" on Page "82"
- "Automatic generation of topology functions" on Page "85"
- "Determining the order length" on Page "90"
- "New properties for the routing path type" on Page "91".
Routing of single-line cables

In the past routing connections could only be generated from multi-line connections. Routing connections can now also be generated from cables with single-line representation. The resulting routing connections are identified by the property **Topology: Generated single-line** (ID 20343). Single-line individual connections can, on the other hand, not be laid.

**Benefit:**

*It is now possible in the topology to route projects configured with single-line without having to draw an additional multi-line representation.*

The multi-line representation takes precedence during routing. This means:

- If a cable has a single-line representation and a multi-line representation, the multi-line representation is used during routing.
- If a multi-line representation is added to a single-line representation, the single-line routing connection is replaced by the multi-line one.

You can use the new property **Topology: Generated single-line** in the connections navigator as a filter criterion and display it as a column in the list view of this navigator.
Consideration of Height Differences during Routing

When planning routing path networks these may contain height differences because, for example, they cover several floors of a building. Vertical routing paths are required in order to connect routing path networks on different floors of a building that belong to each other. Such vertical routing paths are realized in EPLAN through so-called "partial routing paths". These are routing paths with distributed representation that connect two respective routing points on different topology pages with each other.

**Benefit:**

*Partial routing paths can now be used to connect routing path networks that are located at different heights (for example on different floors of a building) with each other. The height difference can be entered at the partial routing path and be displayed in the schematic, and is taken into consideration when determining the total length of the routing paths.*

Partial routing paths

Partial routing paths are routing paths with the function definition "Topology partial routing path". They serve the distributed representation of a routing points and connect two routing points respectively with each other. Partial routing paths are used to connect routing path networks with each other that are located at different heights (for example on different floors of a building). Partial routing paths can also be used to simply continue a routing path network on a different topology page (without a height difference).

Exactly two partial routing paths with the same DT must always exist, of which one is the main function and the other the auxiliary function. The data of the two partial routing paths are synchronized with each other.
You can have the height difference displayed at partial routing paths. This specifies the vertical distance between the routing path networks. The value results from the routing length of the routing path. The following properties are available for partial routing paths to this purpose:

- **Topology: Height difference** (ID 20347): The routing length of the vertical routing path is displayed with preceding sign in this property. The preceding sign "+" means "upwards", "-" means "downwards". The property is only filled if a direction for the height difference was specified.

- **Topology: Direction for height difference** (ID 20348): Specifies the direction for the height difference. Possible values are "None" "Upwards" and "Downwards".

**Procedure**

In order to connect routing path networks on different floors through a vertical routing path, the project must have at least two routing path networks with routing points and routing paths. Usually the routing path networks are located on different topology pages. However, they can also be drawn on the same topology page. The following steps are necessary to generate a routing connection:

- **Insert a partial routing path in the routing path network of the lower floor:** Use the Symbol selection to insert a partial routing path on the routing point from which the vertical routing path is to start. In this context, the special symbol library provides the two new symbols CABDSU and CABDSD (see the section "New Features in the Master Data" (as of Page "134")). Enter the DT and the routing length in the property dialog of this partial routing path and select the entry "Upwards" for the **Topology: Direction for height difference** property. Activate the **Main function** check box.
- **Insert a partial routing path in the routing path network of the upper floor:** Use the Symbol selection to insert a partial routing path on the routing point with which the vertical routing path is connected. In the properties dialog of this partial routing path enter the same DT as at the associated partial routing path and select the entry "Downwards" for the **Topology: Direction for height difference** property. Leave the **Routing length** field empty and the **Main function** check box deactivated.

- **Displaying the height difference:** In the property dialog of the partial routing paths select the property **Topology: Height difference** for both par-
Partial routing paths in the Display tab for the display (if the display is not already set in the used symbol).

- Route connections: A connection between the floors via the vertical routing path is routed when routing the connections via the menu items Project data > Topology > Route. The routing path is listed in the routing track (only once) and the routing length of the routing path is taken into consideration when determining the total length.

**Tip:**
You can rapidly insert a partial routing path by selecting the menu items Insert > Topology > Routing path and then pressing [Backspace]. In the Symbol selection dialog the symbols are already filtered and only symbols with the "Topology routing track" function category are displayed. Below this function category you can select a symbol for a topology partial routing path.

**Automatic generation of topology functions**
In order to route connections that run between different identification structures (for example connections between two enclosures at different mounting locations) the connected functions have to exist as topology functions. In the past these topology functions and the associated routing paths could only be created manually. This procedure has now been simplified and you can also generate topology functions automatically. In addition, you can use a filter to define the topology functions to be generated more precisely.
**Benefit:**

The required topology functions and routing paths no longer have to be created manually when routing between differing identification structures. You can now also generate the topology functions automatically by means of corresponding menu items. In the process a filter can be used to define the topology functions to be generated specifically.

**Structure routing points**

Routing between different identification structures is now carried out by means of the new structure routing points. A structure routing point represents a specific identification structure and the connected topology functions. Topology functions can be generated manually as well as automatically at a structure routing point.

In order to obtain such a routing point, you have to select the new function definition "Topology structure routing point" for the Function definition field on the first tab of the property dialog of a routing point.

Normal routing points serve only to build up the routing path network and can no longer be used to route between different identification structures.

If you have inserted a structure routing point, you can define a filter there for the topology functions to be generated. The new Connected structures tab is now provided to this purpose in the property dialog of a structure routing point.
In this tab you specify a filter that is used during the automatic generation of topology functions. The filter acts on the current structure routing points as well as on those connected to it. For the generation of the topology functions a search is carried out in the multi-line or single-line schematic for those functions that correspond to the identification structure of the marked structure routing point or of the structure routing points connected to it and that additionally fulfill the specified filter criteria.

Entry of the filter criteria is carried out in the same manner as in the known filter dialogs.

💡 Example:
You have inserted three structure routing points on a topology page and have assigned the device tags =A1+O1-U1, =A1+O2-U2 and =A1+O3-U3 to them. The corresponding structure boxes with the same name, which contain different devices, exist in the multi-line schematic for these D Ts. The three structure routing points are interconnected by means of routing paths.

Now you wish to route connections only between the identification structures =A1+O1-U1 and =A1+O2-U2. To do so, open the property dialog for the structure routing point =A1+O1-U1 and specify a filter for the topology
functions to be generated automatically. In this example select the criterion **Mounting location** with the operator "=" and the value O2.

<table>
<thead>
<tr>
<th>Active</th>
<th>Negated</th>
<th>Criterion</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>□</td>
<td>Mounting location</td>
<td>=</td>
<td>O2</td>
</tr>
</tbody>
</table>

When you subsequently use the menu items **Project data > Topology > Generate topology functions > Automatic** to automatically generate the topology functions and then route the connections, routing connections only arise between the identification structures =A1+01-U1 and =A1+02-U2. Without the filter routing connections would also be generated between the identification structures =A1+01-U1 and =A1+03-U3 and between =A1+02-U2 and =A1+03-U3.

**Routing connections with the automatic generation of the topology functions**

The new menu item **Automatic** is available for the automatic generation of the topology functions below the menu path **Project data > Topology > Generate topology functions**. In order to use this option you must have inserted at least two structure routing points and have interconnected these through a routing path. Unplaced topology functions are generated from the multi-line or single-line functions that correspond to the identification structure of the marked structure routing points. The resulting topology functions are connected via unplaced routing paths with the structure routing points.
Further new features:

- The previous possibility of manually creating the topology functions is now realized through the menu items **Project data > Topology > Generate topology functions > Manual**. In the subsequently opened dialog **Generate topology functions** you select the topology functions to be generated – as in the past.

- You can now open the **Generate topology functions** dialog again at any time by using the listed menu path. There you can view the generated topology functions and, if required, change them subsequently. The automatically generated topology functions are also displayed in this dialog.

For further information on this topic please refer to the help system, for example in the section "Routing Connections between Different Identification Structures", and in the context-sensitive help of the **Connected structures** tab.

**Automated Processing**

Topology functions can also be automatically generated during automated processing. To this purpose the new action "Generate topology functions" is available in the **Settings: Automated processing** dialog when you create a scheme for automated processing. This dialog can be accessed by selecting the menu items **Utilities > Automated processing** and then clicking [...] next to the **Scheme** field in the **Run: Automated processing** dialog.

The new action "Route (topology)" has been added to this dialog for the automated routing of connections in the topology.
Determining the order length

In the past only the total length of all the routing connections, cables, tubes etc. with the same part could be calculated and output in summarized parts lists. You now also have the possibility in the summarized parts list to calculate and output the required order lengths of the materials. This allows you, for example to calculate the order lengths of materials that are required to realize the routing paths of a routing path network. Routing paths can consist of materials such as cable ducts, cable trays, conduits, platforms, etc. and have a part. The total lengths of these materials and the required order lengths can be calculated on the basis of the properties of the parts entered at the routing paths.

**Benefit:**

The total lengths of materials to be ordered (for example for the routing path) can be calculated on the basis of the delivery length and be output in summarized parts lists. You can output the order length in meters or as a number of units.

You have to enter the delivery length (in the unit mm) in the parts management for parts of the generic product group "Mechanics", product group "Routing path (topology)" as the basis for the calculation. The new tab **Delivery length** is now displayed to this purpose for these parts.
Calculation of the order lengths

You have to enter a corresponding calculation formula in the form for the summarized parts list to calculate the order length. To this purpose enter a placeholder text with the option **Properties formatted / calculated**.

The following new properties are available for usage in the calculation formula:

- **Delivery length** (ID 22058): Delivery length of the parts. During a part selection or device selection the property is filled with the corresponding value of the delivery length from the parts management. This property is displayed in the property dialog of the routing path in the **Parts** tab ("Parts data" category).

- **Total length with unit of the project** (ID 20513): This property totals up the lengths of all the functions (for example connections, routing paths, busbars, etc.) having the same part.

For more information on this topic please refer to the help system in the section "Determining the Order Length".

**New properties for the routing path type**

A routing path type can be assigned to topology routing paths. The routing path type specifies the way in which connections or cables are routed in this routing path (for example pipe, cable duct, cable platform, etc.). When routing connections the routing path types pre-defined at the routing paths are determined for the routed cables and connections and transferred to these.

When a summarized parts list is output, the functions can be evaluated by the routing path types, so that the time and costs for routing are calculated.
**Benefit:**

When routing connections in the topology you can now use the "Routing path type" to also take into consideration how the connections or cables are routed in a routing path (for example pipe, cable duct, cable platform, etc.). Depending on the respective routing path type, you can calculate the time and the costs for routing.

The following new properties are available to this purpose:

- **Topology: Routing path type (routing path)** (ID 20345)
- **Topology: Routing path types** (ID 20344).

**Entering the routing path type**

The property **Topology: Routing path type (routing path)** (ID 20345) is used to enter the routing path type at topology routing paths. This property specifies the way in which connections or cables are routed in this routing path (for example pipe, cable duct, cable platform, etc.). This results in the routing path type of the connections / cables that are routed in this routing path.

- You can edit the property in the property dialog of a routing path in the form of a selection list. Multilingual input is possible. If you have entered a specific routing path type at a routing path, you can subsequently select these at other routing paths.
- Only one routing path type is permitted per topology routing path.
- This property is available in the topology navigator in the list view and as a filter criterion.
- You can output this property in topology reports.
Output of the routing path type

The property **Topology: Routing path types** (ID 20344) is available for cables and connections. This property outputs the routing path types of the routing paths that a connection routed in the routing path network or a routed cable runs through. The routing path types are listed separated by a semi-colon in the order of the routing tracks.

- The property can be displayed in the graphical editor at the function.
- This property is available in the cable and connection navigator in this list view.
- You can output this property in cable reports and connection lists.
New Features for EPLAN Pro Panel

EPLAN Pro Panel stands for customized enclosure engineering solutions in enclosure construction and automation technology. Electrical engineering planning, 3D mounting layout, manufacturing, and mounting merge, through a uniform data basis, to form a fully integrated solution.

The new functionalities described in the first sections are part of both EPLAN Pro Panel and EPLAN Pro Panel Professional:

- "Standardized and Automated Creation of Manufacturing Drawings" on Page "95"
- "Extensions when Placing Parts" on Page "104"
- "Improved Maintenance of 3D Macros by Means of the Macro Navigator" on Page "105".

The new functionalities described in these sections are part of the Professional version:

- "Extended Settings for Routing Connections" on Page "106"
- "Extensions in the Generation of Manufacturing Data for NC Machines" on Page "107"
- "New Features in the "NC Perforex" Extension Module" on Page "109".
Standardized and Automated Creation of Manufacturing Drawings

You can use *model views, 2D drilling views and copper unfolds* in EPLAN Pro Panel as views for representation and for drawing generation. Additional information such as dimensions, texts, etc. can be assigned to the views for manufacturing. Extensions have been carried out for all forms of these views for Version 2.5. In addition, the model views, 2D drilling views or unfolds used in the documents can now be dimensioned automatically.

Overall the extensions allow templates to be predefined for the manufacturing drawings to be created and to generate the manufacturing documentation standardized and automated to a great extent on this basis.

We discuss the following topics in the next sections:

- "Generating Pages with Views Automatically" on Page "96"
- "Automatic dimensioning" on Page "98"
- "Numbering view names consecutively" on Page "102"
- "Well-structured tab "View"" on Page "103"
- "Rotating drilling views by 180°" on Page "104".
Generating Pages with Views Automatically

It is now possible to automatically generate the pages with the views (model views, 2D drilling views and copper unfolds) in projects with mechanical components in layout spaces. The basis for these automatic reports are report templates with specifications for the pages to be created.

How the views are displayed is specified by means of macros that are created individually and assigned to the report templates. Filter settings in the templates are used to configure the basic items (enclosures, mounting panels, etc.) of which views are created in the layout spaces.

**Benefit:**

*The automatic generation of pages with views on the basis of templates is prerequisite for the standardized and automatic generation of drawings for manufacturing. With this automatic report the time required is reduced to a fraction of that for the manual creation – this means a considerable reduction in time for the creation of documentation ready for manufacturing.*

Creating a macro as preparation

If an existing view is saved as a macro, the settings for the representation of the respective views (viewpoint, style, etc.) are stored as well. Every macro type can be used – with the exception of multi-page macros.

Creating templates

The **Templates** tab has been added to those dialogs that you can access through the menu items **Utilities > Reports > Model views, … > Copper unfolds** or **… > 2D drilling views** to allow automatic generation of pages with views.
You create a new template for example by clicking the button ![New](New). Enter the desired values in the properties of the template. Here properties such as the **Name** of the template, **Start page of report block**, **Filter setting**, etc. are available that should already be known from the other report templates of the EPLAN Platform.

Through the filter settings you specify the basic items of which views are to be created and which hierarchically subordinate items are displayed in the view. Several predefined filter schemes for specific applications are included in the supply.

Other properties furthermore offer you the possibility here to store a manual description of the view or a format for the automatic view description.
In the **Macro** property you enter the desired macro with the stored view. The type of the view contained in the macro have to match the respective report. Otherwise an error message is issued.

**Generate pages**

In order to automatically generate the pages with the views, use either the (Generate report) button on the **Template** tab or the popup menu item **Generate report** in the tree view. If automatically generated pages with views already exist for a specific template, a corresponding prompt is displayed and you can decide whether you want to replace these pages.

Analog to other report pages, automatically generated pages with views are identified by the page property **Automatically generated** with the value "Reports".

**Automatic dimensioning**

The devices of an enclosure and NC-relevant cut-outs (drill holes, sections, etc.) represented in the views and copper unfolds can be dimensioned automatically. The items to be dimensioned and the properties of the dimensioning can be stored as project-specific settings in a scheme. You insert the automatic dimensioning by selecting a corresponding scheme in the property dialog.
Benefit:

Updating of model views now not only takes into consideration the geometric changes in the model view (for example through position changes of the items in the 3D view) – automatically generated dimensionings are also updated.

This results in up-to-date data for subsequent processes, increased quality of the documentation and all-in-all notably higher process reliability.

The new property **Model view: Scheme for automatic dimensioning** (ID 36511) is available in the Properties table of the View tab for inserting the automatic dimensioning. This applies to the following dialogs:

- Model view
- 2D drilling view
- Copper unfold

(If the property is not displayed in the property table, you will need to select it using the property selection.)
In the **Settings: Automatic dimensioning** dialog that you open in the property dialog via the [...] button in the **Value** column, you specify the settings for automatic dimensioning of the items. These settings do *not* apply for manually inserted dimensionings. The following points can be set:

- The **First measuring point** and **Dimension line position** properties of dimensioning
- The items to be dimensioned
- The hierarchy level up to which the items are to be dimensioned
- The position of the measuring point at the item.

In the case of repeated automatic dimensioning the old automatic dimensionings are deleted from a view and subsequently generated again. Additional manually inserted dimensionings are not deleted in the process.

If automatic dimensionings are changed subsequently by the user, for example the position and legibility of the dimension values, these changes are lost when automatic dimensioning is generated again.

**Note:**

Automatic dimensioning is *not* possible in the following views and representations:

- In views that do not view the mounting surface vertically, for example in isometric and side views
- In the 2D panel layout or other graphical representations.
Example:

The following figure shows a model view with automatic dimensioning for mounting rails. In this case the value "Mounting surface, enclosing rectangle" was selected for the setting **Measuring point is applied.**
Automatic dimensioning of items in a row

In order to avoid a confusingly large amount of automatically generated dimensionings at items in a row with the same dimensions, automatic dimensionings are inserted at mounting rails, horizontal rails, busbar systems (supports) and rails in accordance with the following rules:

- The first measuring point is one of the four selectable corner points at the enclosing rectangle of the length-variable support item.
- Only an incremental dimension between the starting and end point of the item is carried out.
- Starting from the first measuring point on the first item in a row is dimensioned, similarly at terminal strips.
- After a gap between two items in a row only the first item in a row is dimensioned again.

Numbering view names consecutively

When the views and copper unfolds of a project are edited it is possible that gaps can arise in the consecutive numbering of the view names (for example when views are deleted). In order to correct this you now have the possibility to renumber the view names consecutively.

To do so select the menu item **Number views** in the **Utilities > Reports** menu path. In the dialog then opened **Number views** you can specify a starting value for the numbering as well as the number of positions that are displayed as a minimum.

The numbering begins at the view with the lowest value and renumbers the views in the existing order consecutively. Irrespective of the view type (model view, drilling view, copper unfolds) and irrespective of the selection made, all the views are renumbered in the complete project.
Well-structured tab "View"

For the current version the View tab of the property dialogs of model views, 2D drilling views and copper unfolds have been structured more clearly. Many of the dialog elements and settings previously located in the upper section have been moved into the table in the Properties group box.

**Benefit:**

*The new layout of the View tab ensures a better overview, faster access and increased comfort in editing the views.*

The following table shows the properties in the respective property tables that were previously available as fields and check boxes in the dialogs Model view, Drilling view and Unfold:

<table>
<thead>
<tr>
<th>Property</th>
<th>ID</th>
<th>Dialog &quot;Model view&quot;</th>
<th>Dialog &quot;Drilling view&quot;</th>
<th>Dialog &quot;Unfold&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model view: Item labeling</td>
<td>36507 X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Model view: Rotation</td>
<td>36514 X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Model view: Selection scheme</td>
<td>36506 X</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Model view: Display item silhouettes</td>
<td>36513 –</td>
<td>X</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Show drilling pattern</td>
<td>36519 –</td>
<td>–</td>
<td>–</td>
<td>X</td>
</tr>
</tbody>
</table>
Rotating drilling views by 180°

The 2D drilling views can now additionally be rotated by 180° counter-clockwise in EPLAN Pro Panel. Rotation by 180° can make sense in order to image layout space views of 3D objects in the "3D viewpoint from below" as well in the drilling view with the same viewpoint.

As of Version 2.5 the View tab of the dialog Drilling view has been structured more clearly. In the course of this change the Rotate drilling views field has been converted into a property of the property table. The new option "180°" is now available in the drop-down list of the Rotation (ID 36514) property for rotation by 180°. The labelings also change their position in the drilling view in accordance with the rotation. However, for them to remain legible, they are not rotated by 180°.

Extensions when Placing Parts

Multiple placement of enclosures with defined spacings

If you use the placement options when inserting enclosures, mounting panels or free mounting panels in a layout space, you can now also access the settings for multiple placement in the dialog Placement options.
**Benefit:**

It is now possible to align mounting panels or complete enclosures exactly and define them in a line up on the basis of the settings for multiple placement. The tedious manual placement via snap points and the definition of spaces are no longer required.

The **Multiple placement** group box has been enabled for the specified components so that you can, for example, enter spacings for the line up of several enclosures. The following known options are available in the drop-down list of the **Placing mode** box for enclosures, mounting panels and free mounting panels:

- "From left to right"
- "From right to left"
- "Individual".

**Improved Maintenance of 3D Macros by Means of the Macro Navigator**

The new macro navigator is now available for a well-structured display and management of the prepared macros stored in a macro project.

With regard to 3D macros and macro projects the new macro navigator offers decisive advantages in the context of the creation and maintenance of 3D macro projects. For the first time the new navigator allows you to structure the 3D macros contained in a 3D macro project without an auxiliary structure or the separation of the macros having to be set up.

For further information on this topic, see the section "New navigator for macro projects" (see Page "15").
Extended Settings for Routing Connections

Orthogonal connection form within routing ranges

In the past the form of a routing connection within a routing range (from the point of entry into the routing range to the point of exit from the routing range) was always diagonal. A new project setting for routing connections now allows you to route the routing connections within a routing range orthogonally.

**Benefit:**

*The option of routing orthogonally in the routing range including the determination of the required length per connection allows you to prepare and carry out a clearly structured mounting.*

The settings for the routing connections are located below the menu path: **Options > Settings > Projects > "Project name" > Routing connections > General.** The new group box **Routing path type in routing range** in the **Route** tab is now available for routing in the routing range with the following options:

- **Diagonal routing:** This is the default setting. The connection is laid diagonally along the shortest route between the entry point and the exit point.

- **Orthogonal routing:** The connection is laid at right angles between the entry point and the exit point.
Extensions in the Generation of Manufacturing Data for NC Machines

Settings for zero position for length-variable items

In the EPLAN parts management you can define drilling patterns for length-variable items (wire ducts, mounting rails, etc.). If you create cut-outs for a length-variable item on a mounting surface, you can now use new settings to specify the side of the item from which the drilling pattern is calculated. This is called a zero position.

Different machines expect this starting point at different points. Therefore this setting has to be customized project-specifically to the machine to be used. These settings are applied during the export of manufacturing data for NC machines.

益处：
The new settings for the zero position means that you can control a notably wider range of machines for manufacturing automation meaningfully.

In the past the zero position was calculated fixed in EPLAN Pro Panel for horizontal items from the left-hand side and for vertical items from the top. These continue to be the default settings. The menu path for the new settings is: Options > Settings > Projects > "Project name" > Machining > Zero position.

Zero position at horizontal item placement:
- **Left**: The drilling pattern is calculated starting from the left-hand side (default) of the item.
- **Right**: The drilling pattern is calculated starting from the right-hand side of the item.

**Zero position at vertical item placement:**
- **Top**: The drilling pattern is calculated starting from the top (default) of the item.

- **Bottom**: The drilling pattern is calculated starting from the bottom of the item.
If the drilling view is activated, the modified settings become visible immediately with [Apply] or [OK].

**New Features in the "NC Perforex" Extension Module**

**Note:**
The "EPLAN Pro Panel Production NC Perforex" extension module is available as an option for EPLAN Pro Panel Professional and EPLAN Pro Panel Professional+.

With this NC interface modules you can transmit the coordinates and dimensions of drill holes, cut-outs and locked areas, as well as other production data to machine mounting panels, doors or side sections directly on the NC-supported Perforex machines of the manufacturer "Kiesling".

**Further material numbers for the Kiesling NC export**

Ten instead of the previous three material numbers are now available in the settings for the NC export to Perforex machines in the General tab. (The menu path for the settings dialog is: Options > Settings > Company > Machining > NC export Kiesling.)
The selectable export formats have been renamed as part of this extension:

<table>
<thead>
<tr>
<th>Old designation</th>
<th>New designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>Windows up to 1.9x</td>
</tr>
<tr>
<td>Windows extended</td>
<td>Windows as of 1.9x</td>
</tr>
</tbody>
</table>

Only if the export format "Windows as of 1.9x" is used, can the assignment of a material be carried out for the additional material numbers 4 to 10. You can also allocate all the assigned materials to individual tools on the Tools tab. This assignment applies only for milling cutters. The corresponding material number is entered.

Three material numbers can be defined at the export formats "DOS" and "Windows up to 1.9x". An assignment of these material numbers to individual tools is not possible at the export formats.

During the export, this number is then selected and transferred to the machine.
New Features for EPLAN Preplanning

EPLAN Preplanning is a CAE solution for use in the basic engineering of machines and plants with the focus on process automation and instrumentation and control technology.

The possible applications range from the P&ID creation in process engineering through the scheme creation in the building automation up to the integration of sensor / actuator lists in basic engineering with EPLAN.

Further information about EPLAN Preplanning is available on our EPLAN Internet pages (under the heading "Solutions > PCT engineering > EPLAN Preplanning").

On the basis of your feedback the functionalities already existing in EPLAN Preplanning have been extended and improved further for this version. In the next sections we will discuss the following new features for pre-planning:

- "Links in Pre-Planning" on Page "112"
- "Configuration of Segment Definitions" on Page "115"
- "Extensions for PCT Loops" on Page "118"
- "Extended Numbering Settings" on Page "120"
- "Creation of Schematics from the Pre-Planning" on Page "120"
- "Checking the Pre-Planning" on Page "122"
- "Properties for Pre-planning" on Page "123".
Links in Pre-Planning

You can now create links in the tree view of the pre-planning navigator. Links can be used to reference existing segments in other structures. This allows you to take into consideration and make clear the dependencies between different segments and structures.

**Benefit:**

Through the use of links you can define dependencies between different segments (for example PCT loops, PCT loop functions, etc.) in the pre-planning, have them displayed in the project and in the schematic, and output in reports. It is possible to generate "locking lists" by customizing corresponding forms. Such a report contains information about those PCT loops that are interdependent and that have to be locked under specific conditions.

Creating links

In order to create a link to a segment in the pre-planning navigator first copy the desired segment in the tree of the navigator and then use the new popup menu item **Insert link** to insert the link at the desired position. Multiple selection is possible when copying and pasting links.

**Tip:**

You can also create links to segments simply by means of Drag & Drop by dragging one or more marked segments to a desired position and by pressing the shortcut key **[Ctrl] + [Shift]** while dragging.

As you are used to from Desktop links, the links are identified in the tree by a blue arrow (icon: 🔄).

---

112
Editing links and linked segments

Actions that you carry out at a link are carried out for the linked segment. For example you open the property dialog of the linked segment by using the popup menu item Properties. Please also note the following points:

- No other object (segment or link) can be inserted below a link.
- The deleting of a link deletes only the link and not the linked segment. If a segment is deleted, the associated links are also deleted.
- In order to jump from the link to the linked segment (and back) in the pre-planning navigator select the popup menu item Go to (cross-referenced) at the selected link.
- A link itself cannot be copied. In order to copy a segment with its link you have to mark both the segment as well as the structure below which the link is located. By using this method you can, for example, insert a segment including its links into another project.
- Links are taken into consideration when creating and inserting pre-planning macros. In order to save a link in a pre-planning macro the same requirements apply as for copying.

Displaying the linked segments

The new indexed property Linked segments: Name [1-10] (ID 44063) is available in the property dialog of the segments in order to have those segments that are linked to a particular segment displayed at the segment. You must use the property selection to select the property to be displayed in the property table. The complete designation of a linked segment is displayed as a value.
Example:

Below the PCT loop TICA+ 1000 there are links to the loop LIRA+ 3000 and to the structure segment FW01 U1.

The following values are displayed in the property dialog of the PCT loop.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Value</th>
<th>Linked segment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linked segments: Name [2]</td>
<td>GW02 LIRA+ 3000</td>
<td>Loop LIRA+ 3000</td>
</tr>
<tr>
<td>Linked segments: Name [1]</td>
<td>FW01 U1</td>
<td>Structure segment FW01 U1</td>
</tr>
</tbody>
</table>

The loop LIRA+ 3000 is located below the structure segment GW02. Therefore the complete designation is GW02 LIRA+ 3000.

At a corresponding configuration of the property arrangements this information is also displayed at the placed segments in the schematic.

Consideration in reports

The links and the segments for which the links were created can also be output in the pre-planning reports. The Placeholder texts - <Form type> dialog has been extended so that corresponding placeholder texts can be placed in the pre-planning forms.

The following elements are now available here for the pre-planning reports (Planning object overview, Planning object plan, Structure segment overview, Structure segment plan):
- **Linked segments:**
  Through this element you can list all the segments that were inserted as a link below a specific segment. You can then see which other segments are linked to this segment through a link.

- **Linked with higher-level segments:**
  Through this element you can list all the segments that were inserted as a link below a specific segment. This allows you to have displayed in which structures a segment was stored as a link in the reports.

You can generate "locking lists" by customizing forms of the type "Pre-planning: Planning object overview" (*.*.f40). Such a report contains information about those PCT loops that have to be locked under specific conditions.

To this purpose insert placeholder texts with the element **Linked segments** and the desired properties into the form. This allows the data of the linked segments to be displayed additionally for a PCT loop (designations, descriptions, limits, etc.).

**Configuration of Segment Definitions**

**Write protection for the structure identifiers pf structure segments**

You can now configure the structure segments of the pre-planning so that only the structure identifiers of one identifier block (for example "Higher-level function", "Mounting location", etc.) can be inserted and edited per structure level in the pre-planning navigator. For example, the "Higher-level function" structure level is used in a project. Through a corresponding configuration it would then be possible that a pre-planning user can then only enter structure identifiers for the "Higher-level function" identifier block at the structure segments of this structure level.
For this purpose, the **Configure segment definitions** dialog has been extended with the **Write protection** tab. The identifier blocks that correspond to the project structure are listed in the **Write protection for structure identifier** table.

Through a check box in the **Write protection** column you specify for selected segment definitions of a structure segment whether the structure identifiers for the respective identifier block may be changed (check box is deactivated) or are write-protected (check box is activated).

If you have activated write protection for a structure segment, the identifier blocks are displayed in the corresponding property dialogs, but the associated structure identifiers cannot be edited.

You cannot configure write protection for the other segment definitions (for planning objects, PCT loops, etc.).
Example:

A write protection has been configured at the displayed structure segment for the structure identifiers of the identifier block "Mounting location". The corresponding cell in the Visible column is grayed-out and cannot be edited.

In this example only the structure identifier for the identifier block "Higher-level function" can be entered and edited.
Extensions for PCT Loops

Improved representation of PCT loops in accordance with the standard DIN EN 62424

The following three properties are now available in the property dialog of the PCT loops for improved representation of PCT loops in the P&I diagram in accordance with the standard DIN EN 62424:

- **Relevant to safety** (ID 44060)
- **GMP-relevant** (ID 44061)
- **Quality relevant** (ID 44062).

**Benefit:**

The new properties allow improved representation of PCT tasks in accordance with the standard DIN EN 62424 for the PCT loops placed in the P&I diagram. On the basis of the symbols displayed additionally in the graphical editor you can recognize whether a placed measuring point or consumer is relevant to safety, or GMP- or quality-relevant.

These properties are additionally available at planning objects and containers.

If you want to carry out such an identification at the measuring points or consumers placed in the P&I diagram, you have to select these properties in the property dialog of the PCT loops by means of the property selection and activate the associated check boxes in the properties table.
You have to subsequently add the properties (ID 44060-44062) to a property arrangement on the View tab so that specific symbols in accordance with the standard can be displayed at the components of the measuring points or consumers in the graphical editor. The symbols are displayed as follows in the graphical editor:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>▲</td>
<td>Relevant to safety</td>
</tr>
<tr>
<td>●</td>
<td>GMP-relevant (GMP stands for &quot;Good Manufacturing Practice&quot;).</td>
</tr>
<tr>
<td>■</td>
<td>Quality-relevant</td>
</tr>
</tbody>
</table>

The properties of the symbols (color, alignment, etc.) can be specified as usual individually at the respective components or project-wide via the layer "EPLAN720, Property placement.Pre-planning".

**Consideration in the navigators for pre-planning**

These properties can be displayed as a column in the list view of the navigators for pre-planning (pre-planning navigator, segment template navigator). In addition, the properties in the pre-planning navigators are available as filter criteria.

**Consideration in reports**

The new properties can be output in the reports, the labeling and the block properties for the planning objects. An activated check box for a property is indicated as usual on a report page by an "X".
Extended Numbering Settings

Retain leading zeros during numbering

On the basis of the settings in the dialog **Settings: Numbering / PCT loops** EPLAN automatically suggests a designation / PCT loop number when creating segments / PCT loops, while copying and pasting and when inserting macros with these objects. (The menu path for the settings dialog is: **Options > Settings > Projects > "Project name" > Pre-planning > Numbering / PCT loops.**)

A new setting has been added to this settings dialog so that leading zeros can be retained in the designations and structure identifiers pf segments and in the designations of PCT loops during this automatic numbering procedure. If this behavior is desired, activate the corresponding check box **Retain leading zeros during numbering.** By default leading zeros are not retained during numbering.

Creation of Schematics from the Pre-Planning

Creation of schematics from the list

If you have stored macros at the planning objects of the pre-planning, schematic pages generated simply from these. In the past the generation of schematics was only possible from the tree view of the pre-planning navigator. To this purpose the planning objects were dragged-and-dropped into the page navigator.

The new popup menu item **Generate new pages from macro** is now available so that this functionality can also be used in the list view. Multiple selection is possible.
**Benefit:**

The new popup menu item *Generate new pages from macro* allows you to generate schematics from the list view of the pre-planning navigator as well. By using an activated filter you can use this in order to carry out a rapid and simple multiple selection in the list view and thus generate several new schematic pages specifically.

**Multiple selection when updating the detailed planning**

Transferring of modified pre-planning data (for example other value sets for the placeholder objects in the macros) to the macros placed in the detailed planning was in the past only possible at individual planning objects.

In the new version the popup menu item *Update detailed planning* in the pre-planning navigator is now also available for superior structure segments. This means that you can update the detailed planning for all the planning objects below a specific segment simultaneously. Multiple selection of segments is also possible. If no placed placeholder objects are found for the selected segments, an error message is displayed.

**Benefit:**

The fact that the popup menu item *Update detailed planning* is now also available at a multiple selection and for all the segments in the pre-planning navigator means that you can update the detailed planning for several planning objects simultaneously.
Checking the Pre-Planning

Display of faulty segments

The Messages in message management (ID 20930) property now also functions for the segments of the pre-planning. After a check run this allows you to filter the pre-planning navigator for faulty segments by creating a filter and using this property as a filter criterion.

Analog to the other navigators the segments with faulty or incomplete information are identified by a red exclamation mark in the pre-planning navigator.

New check run messages for pre-planning

In order to check whether the detailed planning is complete and whether there are planning objects / PCT loops that are not placed in the graphical pre-planning / in the P&I diagram, the message class 028 "Pre-planning" now provides the following new check run messages:

- Message 028020 "Macro at the planning object is not placed in the representation type 'multi-line'."
- Message 028021 "Macro at the planning object is not placed in the representation type 'single-line'."
- Message 028022 "Planning object is not placed in the representation type 'pre-planning'."
- Message 028023 "PCT loop or PCT loop function is not placed in the representation type 'P&I diagram'."

The display of the pre-planning navigator can be reduced to the faulty segments by using the property already mentioned Messages in message management as the filter criterion.
Benutzerfreundlicher Faltplan

Mit dem neuen Faltplan und Filterwerkzeug können Sie zu jeder Zeit einen Überblick über die aktuelle Planungssituation im Projekt erhalten. Im Vorplan-Navigationswerkzeug können Sie alle Informationen zentral zugreifen und sich konzentrieren auf die zu bearbeitenden Objekte. Dies schafft bessere Transparenz in der Projektplanung und in den Anlagen- und Produktdocumenten.

Eigenschaften für Vorplanerstellung

Abweichende Strukturauftragsidentifikatoren bei den Planungsobjekten

Jedes Planungsobjekt kann jetzt eine abweichende Struktur haben im Vergleich zu den übergeordneten Segmenten. Dazu ist die folgende Eigenschaften jetzt verfügbar in der Eigenschaftenauswahl für die Eigenschaftentabelle der Planungsobjekte:

- **Höchstebene-Funktion (Einzelkomponente)** (ID 1128)
- **Montageplatz (Einzelkomponente)** (ID 1228)
- **Funktionszuweisung (Einzelkomponente)** (ID 1328)
- **Installationsort (Einzelkomponente)** (ID 1428)
- **Dokumenttyp (Einzelkomponente)** (ID 1528)
- **Benutzerdefinierte Struktur (Einzelkomponente)** (ID 1628)
- **Höchstebene-Funktionsnummer (Einzelkomponente)** (ID 1728)
- **Produktaspekt (Einzelkomponente)** (ID 1828).

Um eine Struktur zu spezifizieren, die von der übergeordneten Struktursegmenten und Planungsobjekten abweicht, denken Sie an ein großes-Klammern-Symbol (">") vor dem Wert einer solchen Eigenschaft. Durch das großes-Klammern-Symbol werden übergeordnete Strukturauftragsidentifikatoren ignoriert.
Without the use of the greater-than sign you can use these properties to define a separate additional component for the structure identifier for a specific identifier block (for example higher-level function) at the respective planning object.

Renamed properties

In order to differentiate parts data (prices) in the parts management better, the following two properties for pre-planning have been renamed:

<table>
<thead>
<tr>
<th>Old designation</th>
<th>New designation</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price</td>
<td>Calculation value</td>
<td>44018</td>
</tr>
<tr>
<td>Total price</td>
<td>Total calculation value</td>
<td>44019</td>
</tr>
</tbody>
</table>

The **Calculation value** property is selected in the property dialog of a planning object. Here you can enter an estimated value that is required to realize the current planning object (for example an estimated price for a loop).

The **Total calculation value** property is available in the pre-planning reports. It displays the total of the calculation values that were estimated for the realization of the current segment. To this purpose the calculation values of the current segment (at a planning object) and of all the planning objects lying below this segment are added up.
New Features for EPLAN Fluid

Extensions for the EPLAN Fluid Hose Configurator

Since Version 2.4 the EPLAN Fluid Hose Configurator provides users of hydraulics with a program for complete specification of a hydraulics hose line. This program is available both as an add-on variant for EPLAN Fluid and as a standalone variant. A norm-compliant type code is generated automatically in accordance with predefinable sets of rules (such as to DIN 20066) and transferred to the selected hydraulic hose line. This norm-compliant type code allows the hose line to be ordered clearly defined at any supplier.

The following section provides information on the various new extensions to the hose line configurator.

Updating of the type code

You now have the possibility to update the generated type code in the hose line configurator. The new functionality is available as a popup menu item Update type code and additionally in the Configure hose lines dialog of the on-line variant as well as as a button in the toolbar.

The Update type code functionality recalculates the type code for all the marked hose lines. If you have changed the value of a property at a hose line subsequently in the fluid power schematic (for example the hose line length), this functionality can be used to apply the new value automatically in the type code automatically generated.
Benefit:
The **Update type code** functionality allows you to automatically update the type code after a change in the relevant property without having to edit the type code manually.

Central settings dialog for the stand-alone variant
As in all other program variants, the central settings dialog of the EPLAN Platform is now also available in the stand-alone variant of the hose line configurator. To open this dialog select the menu items **Options > Settings**.

In order to access the configuration settings follow the settings categories **User > Add-ons > Hose line configurator** in the tree view. Below the setting category **User > Display > Languages** you now furthermore have the possibility to change the dialog language, select an alternative language, and specify whether you want to call up the EPLAN help system via an Internet connection.
New Features for EPLAN CPM

In the EPLAN CPM (Central Parts Management) program variant parts are managed centrally – outside the actual engineering. The parts data created and managed there can subsequently be made available to all EPLAN users.

Access to the EPLAN Data Portal

With Version 2.5 it is now possible in EPLAN CPM to access the EPLAN Data Portal in order to download device data of well-known manufacturers and, if applicable, also update them.

**Benefit:**

*Through the access to the EPLAN Data Portal you now have the possibility of extending your parts management simply and rapidly by importing parts data without disposing of a full EPLAN system license (for example EPLAN Electric P8, EPLAN Fluid, EPLAN Pro Panel Professional, etc.).*

To open the navigator for the EPLAN Data Portal select the new menu item **Data Portal** in the **Utilities** menu.

**Notes:**

- You must be connected to the Internet in order to use the EPLAN Data Portal, and you must make sure that access is not prevented by a firewall or any other security mechanism! If you have problems, you should first check your firewall, virus scanner, or proxy settings.

- You require a user account to access the EPLAN Data Portal. If you do not have a user account in EPLAN Data Portal, you can create it in the
settings on the Portal tab. Please note that the functional scope of the EPLAN Data Portal depends on your authorization level.

Central setting dialog for EPLAN CPM

In the framework of the innovation mentioned above, the EPLAN CPM program has been extended with the central settings dialog of the EPLAN platform.

**Benefit:**

*With the new settings dialog you can manage those settings that in the past were only available indirectly or not at all centrally in EPLAN CPM.*

As usual in the EPLAN Platform you now select the menu items Options > Settings in order to branch to the settings. In the user settings you can, among other things, carry out the settings for the language of the user interface, for the parts management and for the EPLAN Data Portal. In addition you can now also use the menu items Utilities > System messages to call up the system message dialog in EPLAN CPM.
New Features in the "EPLAN API Extension" Extension Module

Note:
The "EPLAN API Extension" extension module is available as an option as part of our EPLAN Application Developer Network (EADN) as a developer’s package for the following program variants:

A unified, and especially high-performance, programming interface (API, Application Programming Interface) is available for EPLAN platform products. This extension module – the EPLAN API – allows you to develop your own customized solutions in collaboration with EPLAN or other partners. For more information about EPLAN API and EADN, visit the EPLAN web pages under the heading "Solutions > Integration > EPLAN Application Developer Network".

The following section provides information on the various new features of EPLAN API. To use the new EPLAN API version to develop your own applications, you will require the Microsoft .NET Framework 4.0.
**Automatic Generation of Views**

In the EPLAN platform it is now possible to automatically generate pages with views (model views, 2D drilling views and copper unfolds) (see the section "Generating Pages with Views Automatically" (see Page "96"')). The following new methods are available to this purpose in the Reports class of the EPLAN API:

- **CreateViewPlacements**: Creates model views
- **CreateCopperUnfolds**: Creates copper unfolds
- **CreateDrillingViews**: Creates 2D drilling views.

**Creating check runs for parts master data**

In the new version it is now possible to create check runs for the parts master data by means of EPLAN API. You can use the new class `PartVerification` from the `Eplan.EplApi.EServices` namespace to this purpose.

**Specifying the basic item when inserting a model view**

When you insert a model view by using the action `InsertModelViewAction`, you can use the new parameter `ROOTELEMENTS` to now also specify the basic item for the model view.

**Determining the product group allocation of a part**

By using the new properties `GenericProductGroup`, `ProductSubGroup` and `ProductGroup` from the `MDPart` class you can sample or specify the generic product group, product group or product subgroup of a part.
Assigning and splitting planning objects

Analog to the popup menu items **Assign** and **Split** in the pre-planning navigator, you can now also assign a planning object to a function or split it from the function by using EPLAN API. The **Function** class has been extended by the new method **SetPlanningSegment** to this purpose.

Copying pages

In the past it was not possible to copy pages directly via EPLAN API. The **Pages** class now provides the new method **CopyTo** to copy pages (within a project or between different projects).

Importing and exporting of user-defined properties

You can now also import and export user-defined properties by using the EPLAN API. The **PrePlanningService** class contains the two new methods **ImportPropertyDefinitions** and **ExportPropertyDefinitions** to this purpose.

New classes for subprojects

Since Version 2.4 you have the possibility in the EPLAN platform to divide exclusively opened projects into subprojects, file them off for editing and subsequently store them back again. In order to also allow working with subprojects in EPLAN API, the **Eplan.EplApi.EServices** namespace now also provides the two new classes **SubProject** and **SubProjectsCollection** which make corresponding methods available.
Using handles when inserting 3D macros

The Insert3D class now has an enhancement of the WindowMacro method. This method now allows you to use the existing handles when inserting 3D macros into a layout space. This allows you to dock the macros to the 3D snap points of other 3D objects during placing.

Marking a project in the page navigator

So that you can also mark an opened project in the page navigator in EPLAN API the Edit class now also provides the new SelectProjectInPagesNavigator method.

Changing the position of the part references

In the past it was very tedious to change the cell position of the parts references at a function in the EPLAN API. The PartsService parts class now provides the new MoveArticleReference method in order to change the part position more easily.

Nested functions

The new version of the EPLAN API now allows you to determine nested functions. The new property NestedFunctions from the Function class now supplies the functions of the next nesting depth.

Setting of filter schemes for check runs

In the new version it is now also possible to set the filter scheme respectively to be used for the check runs to be added via EPLAN API. To this purpose the ElectroMessage class provides the new property FilterScheme.
Reading in the directory via EPLAN API

Reading in of the directories and the projects contained in them into the project management database can now also be carried out via EPLAN API. To this purpose the `ProjectManagement` class has been extended with the new `LoadDirectory` method. This can be used to automatically update the project management base from a server.
New Features in the Master Data

Master data: Symbols

Note:
The following pages show a number of illustrations of new symbols from different symbol libraries. The illustrations show variant "A" of the respective symbols in multi-line or single-line representation. The name and number of the symbol are shown underneath the symbol.

IEC, GOST, and GB standards

- New symbols have been added to the symbol libraries IEC_symbol, GOST_symbol and GB_symbol. Five new symbols are available to you here:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPT3ST</td>
<td>1193</td>
</tr>
<tr>
<td>SPTS3ST</td>
<td>1194</td>
</tr>
<tr>
<td>QL1_4</td>
<td>1329</td>
</tr>
<tr>
<td>FAH4</td>
<td>1330</td>
</tr>
<tr>
<td>ANT</td>
<td>1573</td>
</tr>
</tbody>
</table>
- New symbols have been added to the symbol libraries `IEC_single_symbol`, `GOST_single_symbol` and `GB_single_symbol`. Nine new symbols are available to you here:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPT3ST</td>
<td>1193</td>
</tr>
<tr>
<td>SPTS3ST</td>
<td>1194</td>
</tr>
<tr>
<td>QL1_4</td>
<td>1329</td>
</tr>
<tr>
<td>FAH4</td>
<td>1330</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>XBS (replacement)*</td>
<td>1375</td>
</tr>
<tr>
<td>XBSK (replacement)</td>
<td>1376</td>
</tr>
<tr>
<td>XBD (replacement)</td>
<td>1377</td>
</tr>
<tr>
<td>XSD (replacement)</td>
<td>1378</td>
</tr>
</tbody>
</table>
* In the case of the symbols identified with "replacement" (in the preceding and in a subsequent listing) symbols already existing have been replaced by new symbols with a modified symbol graphics. These new symbols have "inherited" the names of the symbols already existing. The old symbols received the ending ".1", and the respective symbols were locked:

<table>
<thead>
<tr>
<th>New symbol</th>
<th>Replaced symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>XBS // 1375</td>
<td>XBS_1 // 31,</td>
</tr>
<tr>
<td>XBSK // 1376</td>
<td>XBSK_1 // 161,</td>
</tr>
<tr>
<td>XBD // 1377</td>
<td>XBD_1 // 233,</td>
</tr>
<tr>
<td>XSD // 1378</td>
<td>XSD_1 // 236.</td>
</tr>
</tbody>
</table>

**NFPA standard**

- New symbols have been added to the symbol library NFPA_symbol. Five new symbols are available to you here:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPT3ST // 1193</td>
<td></td>
</tr>
<tr>
<td>SPTS3ST // 1194</td>
<td></td>
</tr>
<tr>
<td>QL1_4 // 1329</td>
<td></td>
</tr>
<tr>
<td>FAH4 // 1330</td>
<td></td>
</tr>
</tbody>
</table>
New symbols have been added to the symbol library `NFPA_single_symbol`. Nine new symbols are available to you here:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Symbol" /></td>
<td>SPT3ST // 1193</td>
</tr>
<tr>
<td><img src="image2" alt="Symbol" /></td>
<td>SPTS3ST // 1194</td>
</tr>
<tr>
<td><img src="image3" alt="Symbol" /></td>
<td>QL1_4 // 1329</td>
</tr>
<tr>
<td><img src="image4" alt="Symbol" /></td>
<td>FAH4 // 1330</td>
</tr>
</tbody>
</table>
Corrections have been carried out for several symbols in all standard symbol libraries (modifications of the function definitions and symbol descriptions, correction of the properties, layers and their placements). This applies to the symbol libraries: IEC_symbol, GOST_symbol, GB_symbol, NFPA_symbol, IEC_single_symbol, GOST_single_symbol, GB_single_symbol, NFPA_single_symbol.

The following symbols have been corrected:
Fluid power

- The following new symbol has been added to the symbol libraries PNE1ESS, HYD1ESS and HYD2ESS:

- The data for the rotation and mirroring of symbols have been checked and corrected (for example position of transformation and insertion points) for all symbols of the symbol libraries PNE1ESS, HYD1ESS and HYD2ESS.

- Corrections have been carried out for the following symbols in the fluid power symbol libraries already mentioned (modifications of the function definitions and symbol descriptions, correction of the properties and their placements):

\[
\begin{align*}
\text{A}_S\_006 & \quad 743, & \text{V}_S\_014 & \quad 874, \\
\text{V}_S\_015 & \quad 875, & \text{EA}_\text{DS}_\text{P}_\text{ANA}_\text{-}3\times3\text{M} & \quad 1331, \\
\text{EA}_\text{DS}_\text{P}_\text{DIGIT}_3\times3\text{M} & \quad 1332, & \text{EA}_\text{DS}_\text{P}_\text{EL}_3\times3\text{M} & \quad 1333,
\end{align*}
\]
EPLAN NEWS
for Version 2.5
Status: 23.06.2015

**Process engineering and building automation**

- In the symbol library HVAC_ESS the symbol representation type after "Pair cross-reference" was corrected for the following symbols:

  - H_01 // 81,
  - RMO // 461,
  - ANT_11 // 611,
  - ANT_12 // 612,
  - ANT_13 // 613,
  - ANT_14 // 614,
  - ANT_15 // 615.

**Special symbol library**

- Three new symbols for topology were added to the SPECIAL symbol library:
In addition, four new symbols for device connection points are available in the **SPECIAL symbol library**:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCPP4</td>
<td>507</td>
</tr>
<tr>
<td>DCPP2O</td>
<td>508</td>
</tr>
<tr>
<td>DCPP2JIC</td>
<td>509</td>
</tr>
<tr>
<td>DCPP2OJIC</td>
<td>510</td>
</tr>
</tbody>
</table>

The graphics has been improved for the following symbols of the **SPECIAL symbol library**:

- BP // 8,
- BPIN // 48,
- BPOUT // 49,
- BP2 // 53.

**All symbol libraries**

- The descriptions of the symbol libraries have been extended and standardized.
Master data: Forms and Plot Frames

The **Function: Connection point designation** (ID 20022) property additionally outputs the connection point description under specific conditions in the reports. This particular characteristic was used in some forms. As of Version 2.5 this property now only outputs the connection point designations of the function in accordance with its definition.

In the respective *forms* for the device connection diagram (*.f05) and the connection list (*.f27) the property 20022 has been replaced by the property **Name of target connection point** (ID 20077):

- F05_001.f05
- F05_001_en_US.f05
- F05_002.f05
- F05_002_en_US.f05
- F05_003.f05
- F05_003_en_US.f05
- GOST_Wire List_A4.f27
- GOST_Wire List_A4_next_page.f27.

**Note:**

If you also used the **Function: Connection point designation** (ID 20022) property in your forms for the additional output of the connection point description, you also have to adapt your forms correspondingly.
The new property **Counter page number** (ID 25020) has been added to the following *plot frames*:

- FN1_001.fn1
- FN1_002.fn1
- FN1_003.fn1
- FN1_004.fn1
- FN1_005.fn1
- FN1_006.fn1
- FN1_007.fn1
- FN1_008.fn1
- FN1_010.fn1
- FN1_011.fn1
- FN1_012.fn1
- FN1_FT006.fn1
- FN1_FT007.fn1
- FN1_PPE.fn1.

💡 **Example:**

The following figure shows the effect of this extension for a project page from the example project.

<table>
<thead>
<tr>
<th>Old:</th>
<th>New:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page 1</td>
<td>Page 1</td>
</tr>
<tr>
<td>Page 167</td>
<td>Page 13/167</td>
</tr>
</tbody>
</table>
Pre-planning

A new form "Data sheet PCT loops" has been created for the pre-planning:

- F41_PP001.f41 (File type "Pre-planning: Planning object plan").

In addition, the associated plot frame has been created:

- FN1_PP001.fn1.

Master data: Function Definition Library

Some new function definitions have been added to the function definition library. For further information on the properties, the basic symbol, etc. of the function definitions listed below in the Function definitions dialog, navigate to the location indicated in the Selection field.

Trade: General

- The following new function definition has been added under General // General special functions // Topology routing track // Topology routing point:
  - Topology structure routing point

- The following new function definition has been added under General // General special functions // Topology routing track // Topology partial routing path:
  - Topology partial routing path

Trade: Electrical engineering

- The following new function definition has been added under Electrical engineering // Cables / Antenna // Antenna // Antenna:
  - Antenna.
Master data: Projects and Templates

- A new basic project IEC_bas002.zw9 has been created on the basis of the project template IEC_tpl002.ept in the context of extended support of the standard DIN EN 81346.

Master data: Macros

Fluid power

- Changes have been carried out in some fluid macros for directional control valves (from the VDMA directory) on the basis of updated fluid power symbol libraries. In addition some identifiers have been corrected in accordance with the standard DIN EN 81346-2:2009 for the symbols in the fluid macros.
Other New Features and Information

EPLAN Solution Center – The New Support System

Since the start of 2013, you have been able to access our new support system online – the EPLAN Solution Center.

**Benefit:**

*The EPLAN Solution Center is an optimized support system with improved service. As a result, we can now process your individual support requests even more efficiently.*

Your inquiries are created and managed in the EPLAN Solution Center on the basis of simple, ergonomic dialogs. Settings once configured are stored automatically for future inquiries. You can view the processing status of your inquiry at any time.

A knowledge database has been integrated into this support system, which already contains a large number of answers to frequently asked questions. As soon as your inquiry is received, the knowledge database – the EPLAN Knowledge Center – automatically suggests initial solutions, provided the topic has already been dealt with before. The knowledge database is expanded continuously.

A link to the EPLAN form is also integrated into the EPLAN Solution Center. This allows you to use the discussion platform directly.

For the time being, the EPLAN Solution Center is only available on the German EPLAN webpages. In the future, we will localize the new support system for further EPLAN languages and install it on a global basis.
Logging Into the EPLAN Solution Center

Only software service customers can log into this support system. To access it, please register online with EPLAN Support. You can reach the registration page, for example, by clicking the "EPLAN Solution Center" hyperlink from within our support section.

From within the EPLAN platform it is also possible to directly jump to the log-in page. For this select the Create EPLAN support request menu item from the Help menu. (This menu item is only active if you have carried out an entry in the E-mail field under Options > Settings > User > Display > User code / Address.) Your Internet browser will then open on the page for logging into the EPLAN Solution Center.
Note:

Please note that you cannot use your login information that you use for logging into EPLAN Support. You must register once before being able to use the EPLAN Solution Center. Enter the e-mail address that you have used so far also for communicating with EPLAN Support in the Email address field, and then click [Register].
To log into the EPLAN Solution Center, enter in the fields **User name** and **Password** the data that you received in a reply e-mail from EPLAN.

Confirm your specifications by clicking [Login]. The first time you log in, you will be prompted to change the password that was assigned to you. Then, the start page of the EPLAN Solution Center opens.

**Validation Code**

To use this new version of EPLAN, you need a new validation code. This is provided on the delivery note sent with your storage medium. In addition, you have the option of retrieving the validation code via the internet (see the following section).

**Retrieving the Validation Code Online**

EPLAN enables you to carry out the final installation step quickly and easily by allowing you to retrieve the validation code required for licensing via the internet. After the required data have been transmitted, the validation code is automatically copied into the license dialog.

**Note:**

Please note that you must be connected to the internet to download the validation code. You cannot retrieve a validation code for network licenses or licenses without a dongle.

The **Enter validation code** dialog has been enhanced to allow you the option of retrieving the validation code online.
This dialog, for example, opens when you start the application for the first time after an installation. Click the new [Retrieve online] button.

The **Company name** and **Serial number** are automatically entered into the open **Set validation code online** dialog. This data is needed to retrieve the validation code successfully.

**Up-to-date information**

If you would like to receive information in the future (such as our eNewsletter), please activate the **I would like to receive further information** check box. EPLAN will then save your personal details (**Name**, **Phone**, **E-mail address**, etc.).

**Internet settings**

The settings for the existing internet connection are adopted by default. You can also use a proxy server as a network component via the **[Settings]** button and the dialog that then opens. If this is the case, you must enter the corresponding information on **Address**, **Port**, etc. Please consult with your administrator about the settings in this area.
Returning the validation code

Click [Send] to send the encoded data to EPLAN. If your details are already held by EPLAN and are valid, a validation code is created and sent to the license dialog. Then start the application by clicking [OK].

Software Requirements and Approvals

**Note:**
The programs of the EPLAN platform are only available as a 64-bit version in the current Version 2.5.

General requirements

The Microsoft .NET framework 4.0 is required to operate the EPLAN platform. Further information and the current version of this Microsoft component are available for download from the Microsoft website.

You will find .NET Framework 4.0 on your EPLAN storage medium. Switch to the following directory:

```
cd-rom\Services\Net Framework 4.0\en_US
```

To install .NET Framework, double-click the file `DotNetFx40_Full_x86_x64.exe`.

Operating systems

The EPLAN platform supports the 64-bit variants of the Microsoft operating systems Windows 7 and Windows 8 / 8.1.

The EPLAN language installed must be supported by the operating system.

The EPLAN platform has been cleared for the following operating systems:
Workstation
- Microsoft Windows 7 SP1 (64 bit) Professional, Enterprise, Ultimate
- Microsoft Windows 8 (64 bit) Pro, Enterprise
- Microsoft Windows 8.1 (64 bit) Pro, Enterprise

Server
- Microsoft Windows Server 2008 R2 (64 bit)
- Microsoft Windows Server 2012 (64 bit)
- Microsoft Windows Server 2012 R2 (64 bit)
- Terminal Server with Citrix XenApp 7.6 and Citrix Desktop 7.6

Microsoft products
Prerequisite for the creation of Microsoft Office file formats from EPLAN is a functioning installation of an Office version as approved by EPLAN on the PC.

- Microsoft Office 2010 (32 bit and 64 bit)*
- Microsoft Office 2013 (32 bit and 64 bit)*
- Microsoft Internet Explorer 10
- Microsoft Internet Explorer 11

*Depending of the selection of the databases for the parts management, the project management and the dictionary, the use of a 64-bit Office version is compulsory.

SQL Server (64 bit)
- Microsoft SQL Server 2008 R2
- Microsoft SQL-Server 2012
- Microsoft SQL Server 2014
Autodesk Server (64 bit)
- AutoCAD 2015
- AutoCAD 2016
- Autodesk Vault 2014 - on the basis of EPLAN EPR/PDM Integration Suite
- Autodesk Vault 2015 - on the basis of EPLAN EPR/PDM Integration Suite

PDF redlining
- Adobe Reader Version XI
- Adobe Acrobat Version XI Standard / Pro
- Adobe Reader Version DC
- Adobe Acrobat Version DC Standard / Pro

PLC systems (PLC & bus extension)
- ABB Automation Builder 1.1
- Beckhoff TwinCAT 2.10
- Beckhoff TwinCAT 2.11
- 3S Codesys
- Mitsubishi GX Works2
- Rockwell RSLogix professional 20
- Rockwell RSLogix professional 21
- Schneider Unity Pro 7.0
- Schneider Unity Pro 8.0 / 8.1
- Siemens SIMATIC STEP 7 version 5.4 SP4
- Siemens SIMATIC STEP 7 version 5.5
64-bit version of the EPLAN platform

Since the EPLAN platform is available as a 64-bit version, please observe the following points:

If you want to use Access databases for the parts management, the project management and the dictionary, both the Microsoft operating system and the Microsoft Office applications (inter alia Microsoft Access) have to be installed completely in the 64-bit version.

If you have installed the Microsoft Office applications in the 32-bit version, you have to use SQL Server databases for the parts management, the project management and the dictionary.

A changeover to SQL Server databases is not possible for EPLAN PPE. In order to use EPLAN PPE in the 64-bit version, both the Microsoft operating system and the Microsoft Office applications (inter alia Microsoft Access) therefore have to be installed completely in the 64-bit version.

Further information (for example about the installation of the 64-bit version, the automatic update of projects, etc.) is available under: http://www.eplan.info/quickstart